


INTRODUCTION
Thank you for purchasing the Yamaha Sound Edge—a high quality sound card with on-board musical instrument
sounds and digital effects bundled with a number of software applications with the power to turn your IBM PC/AT
compatible personal computer into a high fidelity multimedia center.

Sound Edge gives you enormous multimedia potential that will add an entirely new dimension to your computer,
including direct access to the wide world of music, stereo digital sound recording and playback, and much more.

In addition to extremely high fidelity musical instrument sounds, including an “AWM” wave table of real musical
instruments sampled with Yamaha’s Advanced Wave Memory technology, plus a wide selection of “FM” voices
generated by Yamaha’s world-famous Frequency Modulation synthesizer technology, the Sound Edge lets you
play multiple wave data on a musical scale using a sequencer. The sound card also features the high quality
“DSP” (Yamaha’s unique effect processor) which gives you great control over the sound.

The software bundled with Sound Edge consists of the original Yamaha applications EffectGear, VoiceMorph
EffectEdit and SampleEdit, plus various Voyetra applications, including AudioStation, SoundScript, WinDAT, MIDI
Orchestrator, MIDI Orchestrator Plus, and more.

The Sound Edge package includes two owner’s manuals—one for the Voyetra software and the one you’re
reading now.

This owner’s manual covers installation of the Yamaha Sound Edge sound card as well as application installation
for both Yamaha and Voyetra, and use of the Yamaha applications. For information about use of the Voyetra
applications, please refer to the Voyetra User's Guide.

To ensure proper installation and use of the hardware and software, and in order to obtain many hours of fun and
exciting multimedia entertainment from the Yamaha Sound Edge, please read this owner’s manual carefully, and
be sure to keep it in a safe place for future reference.

SYMBOLS USED IN THIS MANUAL
Special symbols which appear throughout this
owner’s manual are as follows:

£

Provides additional information or details about a
feature.

¢
Provides an important notice about features and
other items which require specific attention or
special care.

WINDOWS OPERATION
This owner’s manual assumes that you are already
familiar with basic Windows operation. If you are not,
please refer to the owner’s manual which came with
your Windows software before attempting to install
the Sound Edge hardware and software.

MOUSE OPERATIONS
This owner’s manual refers to the various mouse
operations in the following manner:

CLICK
To press the mouse button once and then quickly
release it. (Unless otherwise noted, this means to
click the left-hand mouse button.)

DOUBLE CLICK
To press the mouse button quickly twice. (Unless
otherwise noted, this means to double click the left-
hand mouse button.)

DRAG
To click and hold the mouse button and move the
mouse pointer to a desired location, and then
release. (Unless otherwise noted, this means to click
and hold the left-hand mouse button.)

NOTICE: The screen displays as illustrated in this owner's manual are for instructional purposes, and may appear somewhat different from the screens
which appear on your computer. Future upgrades of application and system software and any changes in specifications and functions will be announced
separately.



SPECIAL NOTICES

� The Sound Edge software and this owner’s manual are the exclusive copyrights of Yamaha
Corporation.

� Copying of the software or reproduction of this manual in whole or in part by any means is
expressly forbidden without the written consent of the manufacturer.

� Use of the software and this manual is governed by the license agreement which the purchaser
fully agrees to upon breaking the seal of the software packaging. (Please read carefully the
Software Licensing Agreement at the end of this manual before installing the application.)

You should find the user Registration Card included in the package. Please take the time
to fill it out and mail it to the printed address.

� Yamaha makes no representations or warranties with regard to the use of the software and
documentation and cannot be held responsible for the results of the use of this manual and
the software.

� Voyetra®, the Voyetra logo, and the following software titles are all trademarks or registered
trademarks of Voyetra Technologies: Audio Calender™, Audio Screen Saver™, AudioStation™,
MIDI Orchestrator™, MIDI Orchestrator Plus™, Say It!™, Sound Events™, SoundScript™, WinDAT™.

� Windows™ and MS-DOS are trademarks or registered trademarks of Microsoft® Corporation.

� IBM PC/AT™ is a trademark of IBM® Corporation.

� The company names and product names in this Owner's Manual are the trademarks or
registered trademarks of their respective companies.

PRECAUTIONS

� Do not expose the sound card to direct sunlight, excessive humidity, high temperatures,
excessive dust or strong vibrations.

� Before touching the sound card, be sure to touch a metal surface to discharge any static
electricity from your body.

� When holding the sound card, do not touch the inside area of the circuit board or apply
excessive pressure to the card, and be sure to protect the card from contact with water or
other liquids.

� Before installing the sound card in the computer, unplug the power connector of your computer.

� Before connecting the computer to other devices, turn off the power switches of all devices.

� It is possible that computer malfunctions or operator actions might destroy data that was
created with the included application software. We recommend that you back up all important
data onto floppy disks. Yamaha is not responsible for data loss through computer malfunctions
or operator actions.

� The sound card contains no user-serviceable parts, so never touch the inside area of the
circuit board or tamper with the electronic circuitry in any way. Doing so may result in electrical
shock or damage to the sound card.

Yamaha cannot be held responsible for damage caused by improper care and use of the
sound card and software.
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MAIN FEATURES

AWM WAVE TABLE

� Advanced Wave Memory (AWM) tone generation system. Maximum 24-note polyphony permits
simultaneous use of many different instrument voices.

� General MIDI (GM) compatibility. Can play standard MIDI file (SMF) format files.

� The SampleEdit, one of the Yamaha applications, lets you play your own recorded WAV digital
audio files on a musical scale, and with a sequencer program to give you greater access to the
wide world of music.

FM TONE GENERATOR

� High quality FM chip with 20-note polyphony (in 2-operator mode).

� FM tone generator can play in the GM format on the Windows system (excluding drum sounds).

HARD DISK RECORDING—DIGITAL AUDIO

� Permits high quality (stereo) sampling at maximum 16 bit, 48kHz.

� Lets you input sound with a microphone, by direct line input, or from a CD.

� Can play WAV files (digital audio files) using the sequencer program MIDI Orchestrator Plus.

KARAOKE & EFFECTS

� On-board DSP chip effect processor lets you control the effects, change the pitch of a song, or
reduce the volume of the main vocal from a song playing on a CD (for karaoke sing-along). You
can control the DSP with the EffectGear, VoiceMorph and EffectEdit software.

� Effect control software for DOS program such as KPCON and KPLOAD provides high fidelity
sound for games.

OTHERS

� The Sound Edge supports an interface for Panasonic/Creative, Sony and Mitsumi CD-ROM
players.

� The Sound Edge MIDI interface, compatible with MPU-401, allows GM compatible DOS games
and sequencers to play the internal AWM synthesizer.

II
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PACKAGE CONTENTS &
MINIMUM SYSTEM REQUIREMENTS

PACKAGE CONTENTS

The Sound Edge package includes the items listed below, so before beginning, please take a
moment to make sure you have everything you need. (If something is missing, please contact
your authorized Yamaha dealer.)

� Sound card

� Floppy Disk x 4: Install Disk 1, 2, 3, 4

� Microphone (2-lead condenser type)

� Owner’s Manual x 2: Yamaha Sound Edge Owner’s Manual
Voyetra MIDI Orchestrator Plus/Sound Software User’s Guide

� User registration card

MINIMUM SYSTEM REQUIREMENTS

Proper use of the Yamaha Sound Edge requires at minimum the following:

COMPUTER HARDWARE

� Memory
Requires an 80486/25MHz or higher internal CPU with a minimum of 8MB RAM.

� Hard Disk
Proper software installation and running the Sound Edge requires at least 10MB of free space
on your hard disk.

� Floppy Disk Drive
To install the Sound Edge applications software, and to save and load user data.

� Mouse
Requires a Windows 3.1 compatible mouse.

� Expansion slot (ISA16 bits)
Required for installation of the sound card.

DOS
Requires MS/ PC DOS Ver. 5.0 or higher to run Windows 3.1.

Windows
Requires Windows 3.1 or higher.
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OTHERS

Additional hardware as listed below will permit maximum enjoyment of the Sound Edge.

CD-ROM Drive
Sound Edge supports three types of ISA CD-ROM interfaces to save an expansion slot:
Panasonic, Sony and Mitsumi.

JOYSTICK
You can connect a joystick to the MIDI/JOYSTICK connector for use with specified applications.
(Supports an IBM PC/AT series Dsub-15 pin connector.)

POWER SPEAKERS
You can enjoy powerful and dynamic stereo sound by connecting power speakers and other
stereo audio components to the OUTPUT jack.

MIDI ADAPTOR CABLE
The MIDI/JOYSTICK connector allows connection with external MIDI devices for MIDI data
transmission and reception as well as a joystick using the optional Yamaha MIDI Adaptor
Cable (MDC-01).
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CONNECTIONS

MAKING CONNECTIONS

The following diagram shows how to connect the various devices.

¢Before making connections, be sure to UNPLUG THE POWER SUPPLY CORDS OF ALL DEVICES.
After making connections, switch on the power of each device in the following order: External MIDI devices first, then the
computer, then external audio devices. (NOTE: MAKE SURE TO TURN DOWN THE VOLUME LEVELS OF THE
EXTERNAL AUDIO DEVICES BEFORE TURNING THEM ON.) When turning off the power of each device, simply
reverse the process.

¢Improper connection of microphone and other external devices may cause ear injury or damage to
hardware.

£There are various types of audio in and out jacks, so make sure to select the proper cables and adaptors
according to your respective devices.

£For information about jacks, see page 5.

OUTPUTMIDI/JOYSTICK

Dsub
-15 pin

MIC
LINE IN

Joystick

Yamaha MIDI Adaptor Cable MDC-01

Audio Cable

Sound Edge
Sound Card

Mini Jack

Power Speakers

PC/AT Computer

Portable Cassette Recorder
or Stereo (for inputting
external sounds)

Stereo Mini Jack

MIDI OUT

Microphone

CD-ROM Drive

External MIDI synthesizer, etc.

Audio Out
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(Default)
330

320

310

300

OFF
ON

2   1

OFF
ON

OFF
ON

OFF
ON

1 OUTPUT jack: Stereo mini plug type jack outputs standard line-level stereo signals. Allows
connection to power speakers or the inputs of a recording mixer and other audio devices
including headphones.

2 LINE IN jack: Stereo mini plug type jack allows input of line-level stereo signals from
external audio devices.

3 MIC IN jack: Mono mini plug type jack allows connection to the included 2-lead condenser
type microphone (mono). MIC TYPE jumper J1 (see next page) allows use of a 3-lead
condenser type or dynamic microphone.

4 MIDI/JOYSTICK connector: Dsub-15 pin type connector allows connection to a joystick
and/or external MIDI device using the optional Yamaha MIDI Adaptor Cable MDC-01.

5 CD IN connector: Allows stereo input of line-level signals from a CD-ROM. (Left, CN6:
Panasonic; Center, CN3: Mitsumi; Right, CN4: Sony.)

6 CD-ROM connector: Allows connection to a CD-ROM player. (CN5: Panasonic, 40-pin;
CN1: Mitsumi, 40-pin; CN2: Sony, 34-pin.)
* For connection and installation of a CD-ROM drive, see page 71.
* For CD-ROM drives other than Sony, Mitsumi or Panasonic, please use the proper interface
for connecting to your computer. (For details, see the owner’s manual which came with
your CD-ROM player.)

£When you use a joystick or CD-ROM drive, the Configuration setup should be done after connecting the
joystick/CD-ROM drive to the sound card. For more information about the Configuration setup, see page 66.

7 MIDI Port Address switch: Allows change of the MIDI Port Address for triggering the
internal AWM synthesizer sounds when playing DOS games. Four different types of MIDI
Port Addresses can be selected by combining SW1/2’s on/off status. (See pages  6, 16
and 67 for more information.)

¢You may need to change the MIDI Port Address (default address) if some conflict problem occurs. Please
consider which address to use before the sound card installation.

SOUND EDGE SETUP

1. NAMES AND FUNCTIONS

CN6 CN3
CN4

3

1

2

4

J1

CN5 CN1

6

CN2

5 7
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J1  MIC TYPE: Lets you switch back and forth between two types of amplifier configurations
depending on the type of microphone connected. (3-lead condenser or dynamic microphone;
2-lead condenser microphone.)

1 1-2 Short/3-4 Open: 2-lead condenser microphone (such as the one included with Sound Edge).
2 1-2 Open/3-4 Short: 3-lead condenser microphone or dynamic microphone.

* Default position is 1.

J2  OUTPUT TYPE: Lets you select whether to use the internal amplifier on the sound card or
not. Default is set to use the internal amplifier. When using an external amplified speaker,
do not use the internal amplifier. (In this case, use external audio devices having more than
10 kΩ input impedance.)

1 4-6 Short: Outputs the right channel without going through the internal amplifier.
2 3-5 Short: Outputs the left channel without going through the internal amplifier.
3 2-4 Short: Outputs the right channel via the internal amplifier.
4 1-3 Short: Outputs the left channel via the internal amplifier.

J3  LEFT CHANNEL OUTPUT: Lets you select whether to output the left channel to the sound
card’s OUTPUT jack or not. (The left channel signal is always output to the computer’s
internal speaker.) Normally, you should leave this as the default, to output the left channel
signal to the sound card’s OUTPUT jack.

1 3-4 Short: Outputs the left channel to the sound card’s OUTPUT jack.
2 3-4 Open: Outputs the left channel only to the computer’s internal speaker.

* If you wish to use only the computer’s internal speaker, select 2 as shown above and connect an appropriate
audio cable to J3 .

J4  RIGHT CHANNEL OUTPUT: Lets you select whether to output the right channel to the
sound card’s OUTPUT jack or not. (The right channel signal is always output to the
computer’s internal speaker.) Normally, you should leave this as the default, to output the
right channel signal to the sound card’s OUTPUT jack.

1 1-2 Short: Outputs the right channel to the sound card’s OUTPUT jack.
2 1-2 Open: Outputs the right channel only to the computer’s internal speaker.

* If you wish to use only the computer’s internal speaker, select 2 as shown above and connect an appropriate
audio cable to J3 . (Connecting the audio cable to J3  will automatically designate the right channel output to the
computer’s internal speaker.)

J5  PC-SPK (Computer speaker): Lets you input system (“beep”) sounds. The system
sounds come from the computer’s internal speaker via the sound card.
* To hear the system sounds from the computer’s internal speaker via the sound card, unplug one end of the
connector of the audio cable extended from the computer’s internal speaker and connect it to J5 .

J6  INTERNAL LINE IN: Lets you input stereo line-level signals from an MPEG board. You
can apply effects to the input signals using application software such as EffectGear.
* Connect the MPEG board’s output connector to J6 .

J7  MIDI IRQ NUMBER: Lets you select the IRQ (Interrupt Request) number for triggering
the internal AWM synthesizer sounds when playing DOS games. The default is set to 9.
(See pages 5, 16 and 67 for more information.)

¢You may need to change the MIDI IRQ number if some conflict problem occurs. Please consider which
number to use before the sound card installation.

J2

J4

J5

1

1 2

2

3 4

5
3
1

6
4
2

5
3
1

6
4
2

5
3
1

6
4
2

5
3
1

6
4
2

1 2 1 2

Ground Pin1
2
3
4

L Input Pin
Ground Pin
R Input Pin

J6

2 1

: Indicates the Jumper is set to short (ON) position.   

: Indicates the Jumper is set to open (OFF) position.

1

3

J1

J3

3
1

4
2

3
1

4
2

5
4
3
2
1

5
4
3
2
1

1 2
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2
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2. SOUND CARD INSTALLATION
The sound card fits into an expansion slot in your computer.

¢You cannot use more than one sound card. Please remove any other sound card which may already be
installed before attempting to install the Sound Edge.

1. Turn off the computer and unplug its AC power cord.

¢Do not attempt to install your sound card while the computer is plugged in. This can cause irreparable
damage to the sound card, and may pose a serious shock hazard!

2. Remove the top cover of the computer.

£The proper method for removing the top cover varies depending on the type of computer you use, so please
see your computer's owner's manual for the proper procedure. Wear gloves to avoid cuts by any sharp edges on the
cover.

3. To remove the expansion slot cover, simply unscrew it and take it away.

£Be sure to keep the expansion slot cover in a safe place for future use.



8

Sound Edge Setup

4. Carefully remove the sound card from the anti-static bag.

¢Before touching the sound card, first touch a metal surface to discharge any static electricity in your body;
such static electricity can cause serious damage to your Sound Edge. Also do not touch the inside surfaces of your
sound card in order to prevent possible interference with or damage to the circuitry.

5. Hold the sound card with two hands as shown, and slowly and steadily insert it into the
expansion slot, making sure to properly line up the connectors in the card with those in the
slot. To prevent breaking or damaging the sound card during installation, do not use
excessive force when inserting the sound card into the expansion slot.

6. Use the screw from step 3, above, to secure the sound card to the computer.

7. Finally, carefully replace the top cover of your computer.

£To remove the sound card, simply reverse the above process.
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3. SOFTWARE INSTALLATION

Installing the Software

The four floppy disks included in the Sound Edge package—Install Disk 1, 2, 3, 4—contain
both Yamaha and Voyetra application software programs.

¢To ensure proper installation, before installing the software, be sure to exit all applications which may be
active (including Windows) and reboot the MS-DOS.

¢If you removed a previous sound card before installing the Sound Edge, be sure to delete its accompanying
driver programs.

¢When you install the Yamaha Sound Edge application software, the MIDI Mapper will be overwritten.
The installation program also overwrites the AUTOEXEC.BAT, SYSTEM.INI, CONTROL.INI and CONFIG.SYS files. If
you don’t want to lose any existing data, please save them before you install the Sound Edge application software.

Installation Procedure

� Installing for DOS

1. Insert Install Disk 1 into your floppy disk drive.

2. Select the floppy disk drive where the Install Disk 1 is inserted.

£This manual assumes that your floppy disk drive is the A drive. If your drive is different, then choose the
drive specified for your computer.

3. Type A:INSTALL, then press the <ENTER> key.

A:INSTALL + <ENTER>

£You cannot perform installation from the MS-DOS prompt in the Windows Main group, so be sure to shut
down Windows before installing the software.
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When Install Disk 1 is verified, the following screen will appear.

 

£If you want to quit the installation process, press the <ESC> key.

4. Press any key on your computer keyboard.
The Installer screen is replaced by the Name screen.

Select the drive onto which you want to install the Sound Edge software.

£The default setting installs the software to a C drive.
 If you want to use a different drive, type in the name of the different drive. If you intend to use SampleEdit, see page
61, leave the drive name and directory name as their defaults (drive C, \yamaha directory.)

5. Verify the drive name and press the <ENTER> key.
The Installer screen is replaced by the Directory Name screen.

Type the name of the directory into which you want to install the software (or use the
default name).

£The default name is yamaha. You can change the name by typing in a new name. If you intend to use
SampleEdit, leave the drive name as the default.
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6. Verify the directory name and press the <ENTER> key.
The Directory Name screen is replaced by the following screen.

7. Verify the drive and directory name—if correct press <Y>; if incorrect press <N>.

Pressing <N> will return you to the beginning of the installation procedure.

Pressing <Y> will start copying the files for installation. After a few moments, a screen
appears asking if you wish to change AUTOEXEC.BAT file.

8. Press <Y> on your keyboard.
The original AUTOEXEC.BAT file will be saved under a different name and the following
screen appears.

9.  Press any key on your keyboard to continue.
 The following screen appears.
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10. Press either <Y> or <N> on your keyboard.
For Windows users, press <Y> to proceed to Installing for Windows, below.
(For DOS users, press <N> to finish the installation.)

This completes the software installation for DOS.

£If you only wish to use these programs on the DOS, proceed to M16INIT Setup Procedure, page 66.

£You can also use the sound card on your DOS program for game applications.

� Installing for Windows
If you pressed <Y> in step 10, above, the screen will be replaced by the window shown below.
This is where you begin the software installation for Windows.

£ If the Windows installation does not begin, you will need to set up the proper M16INIT configuration
according to your computer's specification. See page 66 for details.

11.Click [OK].

£To stop the installation process, click [Cancel].

The following window appears and installation begins.

The above window will show the progress of the installation for Windows on a graph. Then
the following window appears.

12. Change the disk in the floppy disk drive to Install Disk 2 and click [OK] to continue copying.
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13. Follow the instructions which appear in the dialog boxes to copy all disks, one after another.
When the installation is completed, the Yamaha Sound Edge group and the Voyetra group
will be registered in the Program Manager of your Windows system.

14. Finally the following screen will appear.
Press <Y> to restart your computer.

AUTOEXEC.BAT

The Sound Edge software program will automatically add the following lines to the
AUTOEXEC.BAT file.

rem -- Sound Edge installer wrote. Do not modify here --
echo off
set OPL4DRV=-I9
set MAD16=C:\yamaha\mad16
set BLASTER=A220 I5 D1 T4
C:\yamaha\mad16\m16init /B
C:\yamaha\kpcon /wait:1000 /type:2 /t2aor:2048 /t2aol:2048 /t2dpt:256 /t2mic:512
call C:\yamaha\ymhini.bat C:\yamaha
rem --

CONTROL.INI

The Sound Edge software program will automatically add the following lines to the
CONTROL.INI file.

[drivers.desc]
m16midi.drv=Opti External MIDI Driver
mad16c.drv=YAMAHA Audio Device Driver
opldld.drv=YAMAHA OPL4 Driver
[Userinstallable.drivers]
midi1=m16midi.drv
wave=mad16c.drv
midi2=opldld.drv

mixer=mad16c.drv
[m16midi.drv]
Interrupt=5
Installed=1
[MAD16C.DRV]
DMADAC=0
DMAADC=0
Interrupt=11
IOAddress=530
SingleModeDMA=No

DMABufferSize=32
[OPL4 Driver]
ROM=-1
FM=0
RAM=0
PCM_BOOST=0
AUTO_RESET=0
FAST_DAMP=0
PCM_MIX=0
FM_MIX=0

SYSTEM.INI

The Sound Edge software program will automatically add the following lines to the
SYSTEM.INI file.

[386Enh]
device=vmad16.386
device=vm16midi.386
[boot]
drivers=mmsystem.dll msmixmgr.dll
[drivers]
midi1=m16midi.drv
wave=mad16c.drv
aux=mad16c.drv
midi2=opldld.drv
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ABOUT THE DRIVER AND MIDI MAPPER

In order for Windows to work with MIDI, a driver and MIDI mapper are required. The Yamaha
Sound Edge software installation procedure automatically places the YAMAHA OPL4 Driver in
the Control Panel and the YAMAHA OPL4 MIDI map into the MIDI Mapper.
When you click to open the driver in the Windows Main group, you can see three different
drivers: OPTi External MIDI Driver, YAMAHA Audio Device Driver and YAMAHA OPL4 Driver.

¢If you removed a previous sound card before installing the Sound Edge, delete any accompanying driver
programs.

Setting Up the YAMAHA OPL4 Driver

This driver lets you assign instrument voices from the ROM (AWM wave table), FM tone
generator or RAM (sampled sounds) to each of the 16 MIDI channels.

1. Double click the [Control Panel] icon in the Main group. The following window appears.

2. Double click the [YAMAHA OPL4 Driver] icon. The OPL4 Drive Panel dialog box appears.

bar up and down to change
the volume balance between
the PCM (ROM/RAM) and
FM sounds.

Wave Boost: Click this box
to automatically boost the
melody part by 8dB and the
rhythm part by 10dB.

Auto Reset: Click this box to
reset MIDI data
transmission/reception every
time software playback stops
or pauses.

Fast Damp: Click this box to
cut off the last portion of
notes in order to prevent
notes from interfering with
proper note on of
subsequent notes. Note on/
off data transmission and
reception may sometimes be
disrupted when using a
computer with a slow CPU.

Type of Tone Generation
ROM: GM compatible AWM
wave table.
FM: 128 musical instrument
voices using high quality 2-
operator FM tone
generation.
RAM: WAV files which can
be played on a musical
scale. (See SampleEdit on
pages 47 and 57.)

Ch.: Check the appropriate
box beside each MIDI
channel number to select
the type of tone generation
you want.

ALL ON/OFF: Click one of
these once to select an
entire column of the desired
type of tone generation.
Balance: Move the scroll

£In the default setting all MIDI channels are assigned to “ROM” (the AWM wave table).

3. After choosing your settings, click [OK]. Click [Cancel] to cancel the settings.
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Setting Up MIDI Mapper

MIDI Mapper lets you select either the internal MIDI sound card (OPL4) or an external MIDI
device in order to play MIDI data.

1. Double click the [MIDI Mapper] icon in the Control Panel window.
The MIDI Mapper window appears.

2. Select [Setups], and click the [ ] button in the dialog box. A list appears.

3. Select the proper map according to your setup.
Select [YAMAHA OPL4] to play the internal tone generator (OPL4).
Select [YAMAHA Ex-MIDI] to play an external MIDI tone generator.

£The internal tone generator (OPL4) is selected as the default setting.

¢When you install the Yamaha Sound Edge application software, the MIDI Mapper will be overwritten.
If you don’t want to lose existing data, please save it before you install the Sound Edge application software.
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About the MIDI Interface for DOS
The Sound Edge MIDI Interface lets you use the internal AWM synthesizer to play the
sounds of GM compatible DOS games and sequencers.

When the Sound Edge software installation is done properly, the following lines will automatically be
added to CONFIG.SYS and AUTOEXEC.BAT:

To CONFIG.SYS: DEVICE=C:\YAMAHA\OPL4TSR.SYS  (Device Driver on the DOS system)

To AUTOEXEC.BAT: SET_OPL4DRV=-I9 (Command option which assigns the IRQ number 9
to the Environment Variables)

* The symbol “_” indicates a space in a command.

£If the DOS games cannot run because of a memory shortage of the conventional memory in your computer,
relocate the Device Driver to the UMB/HMA(Upper Memory Block/High Memory Area) area. Change the line in the
CONFIG.SYS to the following and restart your computer.
DEVICEHIGH=C: \YAMAHA\OPL4TSR.SYS

Executing OPL4DRV.COM
1. Set the MIDI Port address of the DOS game to match the MIDI Port address of the sound card

DOS MIDI interface. The default is 330.
      Also select [General MIDI] from the sound setup window of the DOS game.

£See page 67 for more information on the MIDI Port and IRQ.

£Depending on the external devices you use, the games may not run  because of a conflict caused by
the MIDI Port and IRQ settings. If this happens, you must change the MIDI Port address and IRQ number to
the currently available address and number. See pages 5 and 6 for how to change the address and number.
Do not use the same IRQ number as the default for the sound card SB mode, IRQ number 5.

2. Start up the execute program by typing the following command on the DOS command line.

[KEY OPERATION]
CD_\YAMAHA  + <ENTER>
OPL4DRV + <ENTER>

The following display appears.

The above procedure enables you to use the internal AWM synthesizer to play the sounds of GM
compatible DOS games and sequencers. The execute program remains effective until you turn
the power off.

£If you want to cancel the program, type the following line: OPL4DRV2 -R.
Turning the power off also cancels the program.

£If you intend to load the execute program in the UMB/HMA area and start up the execute program,
type the following command:

[KEY OPERATION]
CD_\YAMAHA + <ENTER>
LH_OPL4DRV + <ENTER>

kohei010126
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 　　　�

 SampleEdit
Let’s you play WAV files 

on a musical scale.

�

 　　　　VoiceMorph
Applies interesting effects to 

the input signal and
 synthesizer sounds.

 　　　EffectEdit 
Let’s you create your own effects.

For use with Windows

��
�

�

  �
　　EffectGear

Applies various effects to the 
input  signal and synthesizer 
sounds, and acts as a mixer.

Hello...

?

�

For use with DOS 

DSP

t[x]dpt:[y] 　　　�

KPCON
Let’s you control the 

effects through DOS commands.

　　　　�

　     KPLOAD
Let’s you add various effects

through DOS commands.

DSP

SOUND EDGE APPLICATION SOFTWARE
Sound Edge application programs can be used with Windows or DOS. Running the Sound Edge with
Windows allows you to take full advantage of the complete multimedia capabilities of the software
and hardware.
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WINDOWS APPLICATIONS
The Yamaha Sound Edge has an on-board DSP (effects processor) that can perform various types of effects
on AWM wave table sounds, CD-ROM audio playback, and signals input by a microphone. In Windows the
Yamaha applications EffectGear, VoiceMorph and EffectEdit are used to control the function of the DSP
chip. In addition to the effect related applications, SampleEdit enables waveform editing of sound files and
lets you trigger the multiple wave data on a musical scale with a sequencer. This section explains how to use
these four applications.

¢Please note that EffectGear, VoiceMorph and EffectEdit cannot be used all at the same time, since each
individual effect is created by the single DSP. If you accidentally activate another Sound Edge application at the same
time, the following warning dialog box appears.

The Mixer of the Voyetra AudioStation will also perform the same way, using the single DSP, so you will not be able to
start it for the same reason. Regarding use of the Voyetra applications, see the Voyetra User’s Guide for details.

£If you pull the Volume faders down on the Mixer module of the AudioStation, the volume of Sound Edge
applications will also be attenuated.

EffectGear
Along with the mixer functions EffectGear lets you apply various types of effects to the signal input by a
microphone, the line-level input signal from CD-ROM audio playback, and to the AWM wave table and FM
sounds. The mixer functions for each input (such as microphone and CD audio) let you adjust the relative
volume levels to enjoy karaoke sing-along sessions.

Startup Procedure

Double click on the [EffectGear] icon and the EffectGear application will start.
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Names and Functions

1 ABOUT button: 
Click this button to see information about this version of EffectGear.

2 PULL DOWN MENU button:  
Click this button to open the list of effect types. You can also open the list of effect types by
double clicking on the [Effect] display box.

3 EFFECT display box: 
The name of the currently selected effect type will appear in the display box.

4 POWER OFF button: 
Click this button to exit EffectGear.

5 MINIMIZE button: 
Click this button to resize the EffectGear window to icon size.

6 VOICE CANCEL button: 
Click this button to reduce the volume level of the vocal from a song from CD audio playback
for karaoke sing-along accompaniment.

7 HELP button: 
Click this button to call up EffectGear Online Help, which will appear at the bottom of the
EffectGear window.

8 PITCH SHIFT buttons: 
Click these buttons repeatedly to increase or decrease the pitch of sound by a semitone
(100 cents), which will be displayed on the LED. Original sound pitch is represented by
center position = 0; each click will move the LED display ±100 cents at a time, to a maximum
and minimum of ±400 cents.

9 SLIDERS: 
The function of each slider is represented by an icon located to the left of it. Moving the slider
toward the right will increase the value of each function.

SYNTHESIZER: Lets you adjust the volume of the Sound Card’s synthesizer (AWM
wave table and FM tone generator).

 MICROPHONE: Lets you adjust the microphone input level.

 LINE: Lets you adjust the line input level.

 EFFECT FEEDBACK: Lets you adjust the effect feedback level.

 EFFECT DEPTH: Lets you adjust the range of the effect depth.

 MASTER VOLUME: Lets you adjust the overall output volume level.

£There are similar functions in the Mixer module of the Voyetra AudioStation; however, the pitch shift ranges are not
equivalent.

£Depending on the type of effect you select, Voice Cancel and Pitch Shift may not be applicable, and the button
display will gray out.

4
5

7
6

8

3

9

1
2
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Operation

1. To display the effect type list, click the [Pull Down Menu] button or double click on the
[Effect] display box.

2. Select an effect type from the list which appears.

£There are 32 different types of DSP effects to choose from, including everything from “Hall” and “Room” reverbs to
unique “Alien Voice”, “Devil” and others. These provide an interesting extra dimension to karaoke sing-along or for
game sounds. These are placed in the \YAMAHA\DATA directory (extension .KPE) and you can create your own new
files using EffectEdit to edit them. (See page 23.)

3. To adjust volume balance and level (or range) of an effect, move the sliders right or left. Try
listening to the input signals from a microphone or CD while adjusting the effect level by
moving the slider from right to left.
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VoiceMorph

VoiceMorph lets you apply unique effects to line-level and microphone signals that completely alter the original
sound. You can also apply VoiceMorph effects to AWM wave table or FM instrument sounds when playing
back a MIDI song file with the sequencer program.

Startup Procedure

Double click on the [VoiceMorph] icon and the VoiceMorph application will start.

Names and Functions

1 Menu Bar/Pull Down Menus:

� Source
Lets you select the sound source.

Mic:
Lets you select microphone input. (This is the default setting.)

Line In/Synth:
Lets you select the input source, either [Line In] (CD or other external sound source) or
[Synth] (AWM wave table or FM tone generator).

2

1
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� Control

Gain/LFO Setup:
Lets you open the Control Panel to set up the output (“Gain”) level or the LFO settings.

� Help

Contents:
Lets you open the Online Help.

About VoiceMorph:
Lets you see information about this version of VoiceMorph.

2 Type:
There are 16 different types of voice change programs which will appear in the window.
Selecting [Thru] will let the original sound signal pass through without applying a VoiceMorph
effect.

Operation

1. First select the desired source ([Mic] or [Line/Synth]) from the [Source] menu.

2. Click on the effect type icon that you want.

3. Use a microphone or CD (or other audio device) to input sound to be effected.

Setting Output Level and LFO Settings

You can adjust the output gain level or LFO settings for various effects.

1. Select [Gain/LFO Setup] from the [Control] menu. The Control Panel window appears.

   

Output Gain: Lets you adjust the
output gain level by moving the slider
to the left (Min) and right (Max).

LFO (Low Frequency Oscillator):
Lets you control the depth and speed
of the LFO. The LFO changes sound
pitch, tone or volume in a cycle
determined by depth and speed
values.

• Depth
Adjust LFO depth by moving the
slider to the left (Min) and right
(Max).
• Speed
Adjust LFO speed by moving the
slider to the left (Slow) and right
(Fast).

2. Adjust the Gain/LFO settings for the output level and the LFO.

3. When you’ve finished, click [OK]. The Control Panel window closes and the previous
window appears.

LFO is applicable to the
following effect types: Vibrato,
Stereo Vibrato, Saw, Stereo Saw,
Random, Stereo Random and
Fast Pan effects.
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EffectEdit
Compared to EffectGear and VoiceMorph, EffectEdit gives you more control over the internal DSP, since it can
be used to edit and reconfigure the DSP.
The Sound Edge DSP has four different types of effects programs and provides three different kinds of sound
input—from the AWM wave table and the FM tone generator, from the stereo analog input, and from the mono
input (through a Microphone), and analog stereo output.
EffectEdit lets you fine tune delay time or transpose the pitch of the input sound. You can save your original
effects created with EffectEdit and use them with EffectGear and KPLOAD (DOS).

About DSP Delay, Echo and Surround Effects

Reflection Reflection

�

DSP

��
��RIGHT

Surround  Effect

  Delay Effect   Delay Effect��
��LEFT

Original
Sound

Indicates reflection of sounds.

The DSP digital effect processor processes sound signals electronically to change the pitch
or create artificial ambience—or simulated rooms and other sound environments. A high
quality “delay” unit is at the heart of the DSP, which simulates ambience by delaying the
original sound and creating layers of delayed sounds to mix with the original sound.
The karaoke “echo” sound simulates the delay effect caused by the way sound reflects off
walls in a room. You can create a multi-directional “surround” effect by assigning independent
delays to both the left and right signals.

¢Starting EffectEdit will automatically cancel the present effect setup and some noise may occur. Therefore, please turn
down the master volume in the Mixer window of EffectGear before you start EffectEdit.
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Startup Procedure

Double click on the [EffectEdit] icon and the EffectEdit application will start.

Names and Functions

The EffectEdit window has a pull down menu and block diagram which is configured with various
controllers.

Pull Down Menus

� File

New:
Lets you open a new DSP block diagram by choosing from Type0~3 to edit the effect program
from scratch.

Open:
Lets you open an existing block diagram file; a dialog box will appear for file selection.

Save:
Lets you save the current file, overwriting the existing version; the file extension is .KPE.

Input Caption

When you first save a newly edited file, the Input Caption dialog box will appear before the
Save As dialog box appears. The name you type in here will become the title of your
EffectGear file (file extension .MBJ), and will also appear on the title bar of EffectEdit.

Save As (Name file and save):
Lets you name and save an edited block diagram file. The Save As dialog box will appear.

Make MBJ File (Convert file to .MBJ and save):
Lets you convert an edited block diagram file to an EffectGear format file and save it. (To use
the file with EffectGear, you must save the edited block diagram file as a .MBJ file within the
\YAMAHA\DATA directory.)

Exit:
Lets you exit the EffectEdit program.
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� Memory

Lets you determine the signal processing memory allocation for each controller of the DSP
in the block diagram, including Mic Echo, Key Control and Surround 1 and 2.
Key Control’s DSP memory allocation and Type1’s DSP memory layout allocation are fixed.
When you select [Memory] the Memory Layout setup dialog box appears.

Move the [Balance] slider right or left to adjust the memory allocation. Assign more memory
to Surround to achieve a deeper, longer delay.

� About

Displays information about this version of EffectEdit.
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Block Diagram

When you start EffectEdit the Type0 window appears.

The block diagram let’s you edit effects graphically. In this block diagram, the sound signal is
input through the mixer from the left side, passes through the controllers such as Mic Echo and
Key Control, then goes through a mixer before being output on the right side.

There are four types of effect programs (each represented by a specific block diagram). The
number and kind of controller varies depending on which type you choose.
Click and open each controller setup dialog box to configure the input signal as you like.

Four Types of Effect Programs

Type0:

Sound enters via the Audio/MIDI input, goes through Voice Cancel, then through independent
L (left) / R (right) Key Control pitch shifters, then through the Surround delay.
Voice Cancel reduces the level of the vocal part of a song which is input at the CD IN
connector for karaoke sing-along. You can also shift the pitch (by Key Control) of the entire
sound or apply an echo effect (by Mic Echo) to the MIC input signal.
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Type1:

The Audio/MIDI input goes through Voice Cancel and the MIC IN input goes through the
Key Control pitch shifter, then passes through the Surround delay. Since Key Control is
connected to MIC IN, you can use it to produce special sound effects like those in
VoiceMorph, as well as chorus effects.

Type2:

The Audio/MIDI input goes through Voice Cancel then through two independent Surround
delays. Since Type2 does not include Key Control, you can apply more precise Surround
effects than with Type0 and Type1.

Type3:

All available memory in the DSP is assigned to the two Surround delay effects in order to
produce higher quality surround effects or deeper echoes than possible by Type2.
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Controller and Mixer Setup

There are basically six types of controllers and mixers. Click on either a [controller] or [mixer]
box to open the setup dialog box.

Effect Program Overview (Type0)

SURROUND

?

VOICE CANCEL KEY CONTROL

INPUT MIXER

MIC ECHO OUTPUT MIXER

INPUT

INPUT MIXER
To select the input signal and control the input levels of selected input signals.

VOICE CANCEL
To eliminate frequencies around the vocal of the external input signal, such as a CD, in
order to produce a karaoke accompaniment for sing-along using a microphone.

MIC ECHO
To apply an echo effect to the MIC IN or LINE IN (mono) signal, such as to your own voice.

KEY CONTROL
To shift the pitch, or transpose the key of the input signal. Key Control also lets you apply a
delay effect (Type1 only). You can adjust the key to match your voice range, and create
harmonies (harmonizer effect) by using two independent Key Controls, one set to a higher
pitch and the other set to a lower pitch.

SURROUND
To set up a precision delay. Type2 and Type3 have two Surround effects. You can create
various ambient environments by applying Surround effects to your own singing voice and
karaoke accompaniment.

OUTPUT MIXER
To control the overall levels of the original (“dry”) sound and delayed (“wet”) sounds.
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Mixers

There are three types of mixers: one for input, one for output, and one for remix.

� Input Mixer
The Input Mixer is located on the left side of the dialog box. The input channels are configured
by MIDI L/R, Audio L/R, Audio L as mono and Mic inputs. Each has two lines.
Click on the desired [Input Mixer] to display the Input Mixer setup dialog box.

             

1 Sign:
Lets you control the “phase”, where [+] represents positive phase and [-] represents negative
phase. “N” will cancel the input without having any relation to fader level.

2 Level Fader:
Lets you control input level by moving a level fader.

3 Value:
Displays a numeric level value.

4 Control Menu Box:
Acts the same as that in Windows. Double click the [Control Menu] box to close the Input
Mixer setup dialog box when you are finished making settings.

£Every Control Menu box acts the same way as in the controller setup dialog boxes, described above; therefore,
such explanations will be eliminated hereinafter.

About the Types of Input Channels

You should select the appropriate input channel according to your needs. Be sure to raise
the fader to an appropriate level in order to achieve the desired effect; otherwise the settings
you make will have no effect.

MIDI L/R Channel:
For input from the internal AWM wave table output and input from the internal FM output.

Audio L/R Channel:
For input from the internal digital audio or external LINE/CD signal (stereo).

Audio L Channel:
For input from the internal digital audio or external LINE/CD input (mono).

Mic Channel:
For input from an external microphone.

1

2

3

4
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� Output Mixer
The Output Mixer is located on the right side of the block diagram. The analog L/R output signal
will be output from two separate mixers.
Click the [Output Mixer] box to open the Output Mixer setup dialog box.

          

1 Sign/Level/Value:
Same as for the Input Mixer; however, in this case for signal output.

2 Thru:
To adjust the output level of the original (“dry”) sound.

3 Surround:
To adjust the output level of the delayed (“wet”) sound.

Type1 includes two mixers which remix the sound from the two Key Controls, located in
the center of the block diagram.

Voice Cancel

You can set Voice Cancel to either cancel the vocal part or pass the signal through unaffected.
Type3 does not have the Voice Cancel function.
Click the [Voice Cancel] box to display the Voice Cancel setup dialog box.

1  Th ru :
Passes the original input signal without applying Voice Cancel.

2 Voice Cancel:
Reduces the sounds at the center of the frequency range, or the vocal part of the song
being input, since in most cases this is where the vocal part is located. Use Voice Cancel for
karaoke sing-along to the music without the original vocal part.

2

1

2

3

11

2

3
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Mic Echo

Mic Echo is available in Type0. You can use Mic Echo to delay the input signal or filter the input
signal to modify frequency characteristics.
Click the [Mic Echo] box to open the Mic Echo setup dialog box.

1 IIR Filter (Infinite Impulse Response Filter)
The IIR filter is a cyclic type filter that eliminates a certain frequency range from the original
sound signal.

1 - 1 fc (frequency cutoff)
To determine the point of frequency cutoff in hertz (“Hz”). Click [a]/[z] to modify the
value 100 Hz at a time with each click, or highlight the [fc] box and type in a new value.

1 - 2 type:
Click the [type] button to select the type of filter you want.

Thru:
Passes the original sound through the IIR Filter unaltered.

H.P.F (High Pass Filter)
Lets the high frequencies pass and cuts off the low frequencies as shown
below.

�
Frequency

Level
�
�

Low Frequencies�
�

Cutoff Point

�High Frequencies

L.P.F (Low Pass Filter)
Lets the low frequencies pass and cuts off the high frequencies as shown
below.

�
Frequency

Level
�
�

Low Frequencies

Cutoff Point

High Frequencies

2

1 - 1

2 - 2

1
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2 Delay Design Box
Delay is like a simultaneous echo effect. You can set the time, volume, and number of
delays.

On the right side in the Delay Design box you can set the delay by clicking and dragging the
[red point] up and down to determine the time and volume of delay feedback. As you click
and drag the [red point] to the right, the time location (unit = ms [millisecond]) will appear on
the upper right side of the Mic Echo setup box, along with a black point. After clicking and
dragging the [red point] to the right, also click and drag the [black points] to determine the
number of delays and their time and volume settings.

Key Control

Key Control is available in Type0 and Type1. You can use the Key Control filter to modify the
input signal frequency characteristics, or transpose the input signal, as well as apply delay or
adjust the delayed sound and transposed sound with Type1.
Click on the [Key Control] box and the Key Control setup dialog box appears. (The L/R channel
setups will be displayed on the same dialog box.)

       

1 IIR Filter (Type0):
See Mic Echo, above, for information about the IIR filter.

2 Key Shift (Type0):
To transpose the input signal within ± two octaves. Units are cents. Click [a]/[z] repeatedly
to adjust the key up or down 100 cents (a semitone) at a time, or highlight the [pitch] value
box and type in the desired value.

3 Delay Design Box (Type1):
To set the time, volume, and number of delays.

4 Delay (Type 1)
To adjust the output level of the delayed sound.

5 Key Shift (Type1):
To adjust the output level of the transposed sound.

2

2

3

2
1

3

1

Type1

Type0

2 4 5

4 5

1

1

Sign ＋            

Sign－�

Time

Volume
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Surround

With Surround you can apply precise delay effects to the input signal.
Click the [Surround] box and the Surround setup dialog box appears.

1 Input:
Same as Sign/Level/Value in the Input Mixer, above; however, in this case it adjusts the
signal level input to the Surround.

2 IIR Filter:
See Mic Echo, above, for information about the IIR Filter.

3 Delay Design Box:
Delay is like a simultaneous echo effect. You can set the time, volume and number of delays.
See Mic Echo, above, for information about the Delay Design Box.

£
• “Reverse” from the Surround box indicates signal sound loop. •
Output which feeds back into input indicates signal sound loop for each setup window.
• Surround 2 in Type2 and Type3 has an input channel exclusive to the signal sound loop as well as other inputs.
• The number of delays in the Delay Design Box may vary depending on the controller.
• Depending on the Memory setup (see page 25), you cannot set up the delay feature (e.g., if you allocate too much
memory to others, such as Mic Echo).

3

3

1

2
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Operation

This section describes basic operations and provides a tutorial showing how to create an effect
program.

We’ll make an effect by using a microphone input sound split into two voices, one an octave
higher (right channel) and one an octave lower (left channel) than the other, and adding an echo
type effect to them. This effect is similar to some effects in VoiceMorph.

First connect a microphone to the MIC jack of the Sound Edge sound card.

1. Select [New] from the [File] menu on the menu bar.
The Type Select dialog box appears.

Select [Type1], then click [OK]. The Type1 block diagram will apply Key Control to the
microphone input sound.

 
1

 

Transpose
To make the voices one octave higher and one octave lower from the original voice, you’ll
need to modify the Pitch (pitch of the input voice) using Key Shift in the Key Control dialog
box. First you’ll need to raise the microphone input level of the 4th and 5th (from the top)
Mixers.

2. Click the 4th (from the top) [Input Mixer]. The Input Mixer setup dialog box appears.
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3. Click and drag the [Mic input level] fader upward and set it to a value of about 80. Double click
the [Control Menu] box in the upper left corner to close the Mixer box.

4. Click the 5th (from the top) Input Mixer box to open the Input Mixer setup dialog box, then
click and drag the [Mic input level] fader also up to 80. Double click the [Control Menu] box in
the upper left corner to close the Mixer box.

5. Click the [Key Control] box. The Key Control setup dialog box appears.

6. On the right side of the Key Control setup dialog box, click and drag the [output level] fader for
both upper and lower KeyShift to maximum.

7. Modify the pitch one octave higher in the upper 1 Key Shift by clicking [s] to 1200.
Listen to your voice to verify the value while modifying the pitch.

8. Modify the pitch one octave lower in the lower 2 Key Shift by clicking [t] to -1200.
Double click the [Control Menu] box to close Key Control.

£You should be able to hear the right channel sound one octave higher and the left channel sound one octave
lower than their normal settings.

1

2
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Apply Echo
Now let’s apply an echo effect. You’ll need to increase the Surround output level on the right
Output Mixer to audition the amount of echo while modifying the setting.

9. Click the [Output Mixer] box to open the Output Mixer setup dialog box, then click and drag
the [Surround] fader to increase the Surround output level to maximum position. There are
two Output Mixers. Set both to the same value.

                   

Double click the [Control Menu] box in the upper left corner to close the Output Mixer.

10. Click the [Surround] box. The Surround setup dialog box appears.

11. On the left side of the setup dialog box, increase the input level by clicking and dragging
both [L/R] level faders to maximum positions.

12. Drag the [red point] on the left side of the upper (R) Delay Design box to the position on
the right as shown in the above illustration.

£The red colored graph indicates feedback delay time and volume. Time location (unit = ms [millisecond]) will
be displayed on the upper right side of the Delay Design box as you drag. Also, the red point in the lower (L) delay
design box will automatically move according to the delay time that you previously designated, above.

£By listening to your voice while you make settings, you can better judge the amount of echo applied.

£After moving a red point, a black point will appear in the red point’s original position.

(Red)

(Red)
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13. Drag the [black point] to the right as shown in the illustration on the previous page.
When you move the black point to a new location in the upper (R), the time location of the
black point in the lower (L) will adjust accordingly. There are seven black points in total.
Double click the [Control Menu] box in the upper left corner to close the Surround setup
dialog box.

Saving the Effect Program
After modifying setups you will need to save the effect program (.KPE). You may create a
.MBJ file so that you can use your new effect program with EffectGear.

14. Select [Save] from the [File] menu.
The Input Caption dialog box appears (if your edited effect file is new).

15. Type in the caption name, then click [OK].
(This caption will become the file title in the EffectGear’s effect type list.) After the Input
Caption box closes, the Save As dialog box appears.

16. Type the drive name, directory and file name where you want to save your new effect file.
You can use any file name, but type .KPE at the end of the file name.

17. If you wish to use this newly edited file with EffectGear, select [Make MBJ file] from the
[File] menu and the Save As dialog box appears.

18. Make sure the \YAMAHA\DATA directory is selected, then save the file, using .MBJ as the
file extension.

£Save .MBJ files in the \YAMAHA\DATA directory. If a .MBJ file is in another directory, you cannot use it with
EffectGear.

EffectEdit has powerful sound sculpting capabilities. The graphic DSP editing features let you
easily make precise adjustments to the sound. Select another type of effect and try creating
your own original effect program.

EffectEdit Sample File

In addition to the preset .KPE files for EffectGear, the \YAMAHA\DATA directory includes
.KPE sample files as additional examples to help you understand the function of the
controllers, which will give you practical information before actually using EffectEdit. You
can easily make your own original files by editing a sample file that’s close to the effect
that you want to create.

Sample File List

File name Effect type Contents

KARAOKE.KPE 0 For karaoke effect, echo effect for microphone
input signal, VoiceCancel and Pitch Shift for CD
input signal.

HARM-MJ.KPE 1 For three-voice harmony effect. Delay effect
creates expanding ambiance.

DELAY.KPE 2 Creates typical delay effect.

REVERB.KPE 3 Creates typical reverb effect.
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SampleEdit

You can use SampleEdit to read wave files, edit the waveforms, and play them as melodies.
You can use the SampleEdit downloading feature to use wave data files recorded by other application software
(such as WinDAT, or MIDI Orchestrator Plus that are included with Sound Edge) as tone generators for
sequencers (such as the MIDI Orchestrator Plus) in the same way as the Sound Edge synthesizer (AWM/
FM).
The following diagram shows the organization of SampleEdit.

Read the wave file Waveform editing window

Parameters dialog box

Mapping window

MIDI soft keyboard 
(audition feature)

MIDI Orchestrator Plus

£For a list of the .OPL and .OMP sample files included with the SampleEdit, see page 61.
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Files Usable with SampleEdit

You can use three types of files with SampleEdit: .WAV, .OPL, and .OMP. Of these three,
.WAV and .OPL files can be read for waveform editing. After waveform editing, the files are
saved as .OPL files. The .OMP files are created by assigning .OPL files in the Mapping window
as a list. Creating these .OMP files enables you to use various wave data as instrument sounds.

Waveform Editing Window

The waveform editing window displays the waveform of a read wave file. In this window, you
can edit the waveform—for example, by magnifying and editing it as if you were using a word
processor with commands such as [Cut], [Copy], or [Paste]. You can audition or play the wave
data being edited in various ways—for example, you can produce sounds using the MIDI soft
keyboard, or by pressing the play button in the toolbar.

Parameters Dialog Box

During editing, you can use the Parameters dialog box to set various parameters of the wave
data. For example, you can change the instrument voice by setting the envelope parameters,
or you can add vibrato or tremolo effects by setting the effect parameters. Also, SampleEdit
provides parameters to control tuning and volume so that you can finely tailor the wave data as
an instrument sound.

Mapping Window

In the Mapping window, you can assign edited wave data to a program change number and
download the data (i.e., send the data) to the sound card RAM. This enables the wave data to
be used as instrument sounds by a sequencer such as the MIDI Orchestrator Plus.

About Sample Files

The sample files that will be installed automatically when installing the Sound Edge software
contain various types of .OPL files and .OMP files. By examining these sample files, you
can understand the various possibilities and methods for using SampleEdit. You can
reference these sample files and then make your own original file from scratch or, if there
is a sample file that is close to what you want, you can edit the file to make your own
original file. For details, see page 61.
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Startup Procedure
To start SampleEdit, double click the [SampleEdit] icon in the YAMAHA Sound Edge group.

Names and Functions

1 Toolbar:
Lets you execute various features just by clicking on buttons. The toolbar can be displayed
when necessary. To display or erase the toolbar, use the [View] menu.

2 Work area:
Lets you edit wave files in the Waveform editing window, and lets you open the Mapping
window. Also lets you display and use the MIDI soft keyboard.

3 Status bar:
While you are editing, the status bar displays various statuses of wave data.

Toolbar

1 New .OMP file button:
Creates a new .OMP file. To open a new Mapping window, click this button.

2 File Open button:
Opens a dialog box that is used to select the file to be read. You can select the .WAV,
.OPL, and .OMP file types.

3 Save button:
Saves, by overwriting, the currently active file. If the file has not been previously saved,
the Save As dialog box appears.

4 Undo button:
Undoes the immediately preceding edit operation.

5 Cut button:
Copies the selected area to the clipboard, and deletes the selected area from the window.
The waveform area to the right of the selected area moves to the left when the selected
area is deleted.

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17
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6 Copy button:
Copies the selected area to the clipboard, but does not affect the selected area in the
window.

7 Paste button:
Pastes the contents of the clipboard into the specified position. The waveform area following
the specified position is moved to the right to accommodate the new data.

8 Reverse button:
Reverses the selected area. The beginning and end of the selected waveform area are
reversed.

9 Inverse button:
Inverts the selected area. The top and bottom of the selected waveform area are inverted.

10 Normalize button:
Normalizes the selected area (by maximizing the peak value; the rest will be scaled
automatically by the same factor). This allows non-distorted correction of data that was
recorded at an extremely low level.

11 One Play button:
Adds silent data to the end of the sampling data. This cancels the loop playbacks so that
you can execute a single playback.

12 Zoom In button:
Magnifies the display of the selected area.

13 Zoom Out button:
Returns the display to the size before the zoom in.

14 Unzoom button:
Displays the entire waveform.

15 Stop button:
Stops playback of the active wave data.

16 Start button:
Plays back the active wave data.

17 OPL4 Driver button:
Opens the OPL4 Drive Panel window. For details on the OPL4 Drive Panel, see pages 14
and 42.

£Most of the features in the toolbar can also be executed by clicking the relevant menu in the menu bar, and
then clicking the relevant command in the pulldown menu.

Status Bar

1 Loop/Note:
During waveform editing, indicates the starting point of a loop by showing the number of
samplings from the beginning. When the MIDI soft keyboard is active, displays the pitch of
the clicked keyboard by showing the note name.

2 Region:
During waveform editing, displays the start and end points of a selected area.

3 Displays the bit length for the wave data being edited.

4 Displays whether the wave data being edited is monaural or the left (L) stereo channel. If
the wave file that was read is a stereo sample, only the left channel data is read and the
waveform displayed in the editing window is for the left channel only.

5 Displays the sampling rate in Hertz for the wave data being edited.

6 Displays the size in Bytes for the wave data being edited.

1 2 3 4 5 6
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Setting the YAMAHA OPL4 Driver

To use wave data (read by SampleEdit) to produce sound (for example by using the
MIDI soft keyboard or a sequencer), you must select RAM as the sound generator in the
OPL4 Drive Panel window.

1. In the toolbar of the SampleEdit window, click the OPL4 Driver button [ ]. The
OPL4 Drive Panel window appears. You can also open the OPL4 Drive Panel window
from the Control Panel in the Main window in Windows. (See page 14.)

£If the toolbar is not displayed, click [View] in the menubar then [Tool bar] from the pulldown menu. The
toolbar appears.

6
5

7

4

1

3

2 -32 -12 -2

2. Click each [RAM] box to select RAM as the tone generator for each MIDI channel (channels
1 to 16). If necessary, select [ROM] (AWM wave table) or the FM tone generator. Also, if
necessary, adjust the volume levels between ROM and FM.

3. After finishing the settings, click [OK] to apply the settings or click [Cancel] to cancel the
settings.

1 Ch.: Lets you choose the tone generator that you
wish to use for each MIDI channel.

2 Type of tone generator.

2 -1 ROM: AWM Wave table for standard GM.

2 -2 FM: 2-operator FM tone generator with 128
instrument voices.

2 -3 RAM: Uses wave tables read by SampleEdit
as tone generators.

3 ALL ON/OFF: Lets you simultaneously set all the
MIDI channels within the same tone generator to
ON or OFF.

4 Balance: Lets you adjust the volume balance
between tone generators [PCM (ROM/RAM) and
FM].

5 Wave Boost: Lets you increase the volume of the
melody part (=8db) and the rhythm part (=10db).

6 Auto Reset: Lets you reset the MIDI information
each time a sequencer, such as a media player,
stops or pauses.

7 Fast Damp: Cuts off the last part of a MIDI note
and sounds the following note. You should choose
this when the “note-on” and “note-off” functions are
likely to be interrupted (for example, on a computer
with a slow CPU).
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� File Menu

New OMP:
Creates a new .OMP file. Displays the new Mapping window.

£For details on the Mapping window, see page 58.

Open:
Displays a dialog box in which you can select the file to be read. You can select three file
types: .WAV, .OPL, and .OMP.

Close:
Closes the active file. If the file has not been saved, a save-confirmation message appears.

Save:
Saves, by overwriting, the currently active file. If the file has not been previously saved, the
Save As dialog box appears.

Save As:
Displays the Save As dialog box in which you can name and save the file. In the Save As
dialog box, you can save an existing file under another name.

File List 1, 2, 3, 4:
Displays the names of the files that were most recently opened. Up to 4 filenames can be
displayed. You can open one of these files without using the Open dialog box by clicking
on the file name.

Exit:
Quits the SampleEdit application.

Menus
Available menus depend on the currently active window.

When the waveform editing window is active

When the MIDI Soft Keyboard window is active

Menus

When the Mapping window is active
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� Keyboard Menu

Displays the MIDI Soft Keyboard window.

You can sound the wave data being edited or a synthesizer (AWM/FM) by clicking on the
keyboard.

£You can play the sound of the tone generator selected in the OPL4 Drive Panel window. The OPL4 Drive
Panel window is displayed by clicking on the   button in the toolbar.

� MIDI Menu

Instrument (Patch):
Selects the program change number (Patch number). When you choose [Instrument] from
the [MIDI] menu, the various types of voices are displayed along with the names of the
instrument voices within each category.
You can select any of the displayed instrument voices. You can use the active MIDI soft
keyboard or the Start button to audition (play) the instrument voice (wave data or synthesizer)
that corresponds to a number selected here.
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£The names of the instrument voices displayed here conform to the GM instrument voices (GM System
Level 1).

£For details on the program change numbers of wave data, see page 48.

Parameters:
Sets parameters such as the MIDI channel for the wave data being used.

1 MIDI Channel:
Sets the MIDI send channel. Valid channel numbers are from 1 to 16. The default value is
channel 1.

2 Octave:
Lets you raise or lower the scale of the entire keyboard, which enables you to change the
range of sound produced by the MIDI soft keyboard. You can raise or lower by a maximum of
three octaves (in full octave units). For example, selecting +1 raises the scale by one octave;
selecting -1 lowers the scale by one octave. The default value is the normal scale without any
octave change.

3 Velocity:
Sets the velocity (the strength or volume level of the sound based on a click of the mouse).
The velocity is from 0 (minimum) to 127 (maximum). The default value is the maximum.

4 OK:
To apply any parameter settings, click the [OK] button.

1

3
2

4
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� View Menu

Toolbar:
To display the toolbar, select [Toolbar].

Status Bar:
To display the status bar, select [Status Bar].

� Edit Menu
The [Edit] menu is available only when the waveform editing window is active. Other than the
command [Select All], all the commands in the [Edit] menu are also available in the toolbar.

Undo:
Undoes the immediately preceding edit operation.

Cut:
Copies the selected area to the clipboard, and deletes the selected area from the window.
The waveform area to the right of the selected area moves to the left when the selected
area is deleted.

Copy:
Copies the selected area to the clipboard, but does not affect the selected area in the
window.

Paste:
Pastes the contents of the clipboard into the specified position. The waveform area following
the specified position is moved to the right to accommodate the new data.

Select All:
Selects all of the entire waveform.

£The clipboard is a special SampleEdit clipboard and is different from the standard Windows clipboard.
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� Effect Menu
The [Effect] menu is available only when the waveform editing window is active. All the
commands in the [Effect] menu are also available in the toolbar.

Reverse:
Reverses the selected area. The beginning and end of the selected waveform area are
reversed, so that the sound plays backwards.

Inverse:
Inverts the selected area. The top and bottom of the selected waveform area are inverted.

Normalize:
Normalizes the selected area (by maximizing the peak value; as a result, the rest will be
scaled automatically by the same factor). This allows non-distorted correction of data that
was recorded at an extremely low level.

One Play:
Adds silent data to the end of the wave data. This cancels the loop playbacks so that you
can execute a single playback.
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� Zoom Menu
The [Zoom] menu is available only when the waveform editing window is active. All the
commands in the [Zoom] menu are also available in the toolbar.

Zoom In:
Magnifies the display of the selected area.

Zoom Out:
Returns the display to the size before the zoom in.

Unzoom:
Displays the entire waveform.

� Parameters Menu
The [Parameters] menu is available only when the waveform editing window is active. Click
the [Parameters] menu to display the Parameters dialog box. In the Parameters dialog box,
you can choose the settings for each parameter of the currently active wave data.

Envelope:
These parameters let you shape the sound of each voice, i.e., set how the level of the
sound changes over time. You can use these parameter settings to simulate the envelope
curve of various musical instruments or to change instrument voices.

1

2

3

4
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12

13

Envelope

Common

Effects

15 14

kohei010126
14



49

Sound Edge Application Software

Time

Level

Maximum

Minimum

1 Attack Rate
2 Decay 1 Rate

3 Decay Level

5 Release Rate
Key OffKey On

4 Decay 2 Rate

1 Attack Rate:
Sets the attack time—that is, the time it takes for a sound to reach the maximum level after a
key is pressed. The higher the value, the faster the sound reaches the maximum. The initial
value is 15.

2 Decay 1 Rate:
Sets the time it takes the sound level to decay from the maximum level to the decay level.
The higher the value, the faster the decay time to reach the decay level. The initial value is 2.

3 Decay Level:
Sets the decay level. The higher the value, the larger the decay level. The initial value is 14.

4 Decay 2 Rate:
Sets the time it takes the sound to decrease from the decay level. The higher the value, the
faster the decay time. The initial value is 0.

5 Release Rate:
Sets the time it takes the sound to sustain after a key is released. The higher the value, the
faster the sound cuts off. The initial value is 15.

Common:
Parameters common to the entire waveform.

6 Sample Note:
Assigns the original pitch of the wave data to a note number. Valid values are from 0 to 127.
The initial value is 60.

7 Fine Tune:
Permits precise tuning. Valid values are from –100, through 0, to 100 (100 cents=a semitone).
The initial value is 0.

8 Total Level:
Sets the output volume. Valid values are from 0 to 127. The initial value is 0.

9 Sample Frequency:
Sets the sampling frequency for the wave data.

Effects:
Parameters that let you create effects such as vibrato or tremolo.

10 LFO Speed:
Sets the LFO speed. Valid values are from 0 to 8 (maximum). The initial value is 5. This
setting changes the vibrato or tremolo effect.

£LFO (Low Frequency Oscillator) is an oscillator that generates low-frequency signals and is used to create
vibrato or tremolo effects.
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11 Vibrato Depth:
Sets the depth of the vibrato effect. Valid values are from 0 to 7 (maximum). The initial value
is 0.

12 Tremolo Depth:
Sets the depth of the tremolo effect. Valid values are from 0 to 7 (maximum). The initial value
is 0.

13 Pan:
Sets the apparent sound orientation for stereo. Valid values are from -7 (left-most), through 0
(center), to 7 (right-most). The initial value is 0.

14 OK:
To apply any parameter setting changes, click the [OK] button.

15 Cancel:
To cancel any parameter setting changes, click the [Cancel] button.

� Window Menu

Cascade:
Displays the windows organized as a series of overlapping windows.

Tile:
Displays the windows organized as a series of side-by-side, top and bottom windows.

Arrange Icons:
Displays the iconized windows organized as in rows.

� Help Menu

Contents:
Displays Online Help.

Search for Help on:
Displays the Search window.

How to Use Help:
Displays information on how to use the Help system.

About SE:
Displays version information about SampleEdit.
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Reading Wave Files

You can read wave files recorded by other application software and files of previously created
material, and you can edit the waveforms. SampleEdit can handle the following three types of
files, but only files that have the .WAV or .OPL file extension can be read and used for waveform
editing.

.WAV (Waveform Audio):
The standard format for digital audio files used in Windows.

.OPL (OPL Waveform Audio):
The wave file format to which has been edited and added the parameters of the internal tone
generator(OPL4).

.OMP (OPL Download Map):
The file format with the .OPL files assigned and listed in the Mapping window. For details on
.OPL files, see page 60.

£SampleEdit is compatible with the following wave data: 8 or 16 bit; 11.015, 22.050, or 44.1 kHz sampling;
monaural. If the wave file that was read is a stereo sample, only the left-channel data is read and displayed.

Reading Procedure

1. Choose [Open] from the [File] menu. The File Selection dialog box appears.

2. Select the desired wave file. Click [OK]. When a .WAV file or .OPL file is read, the waveform
editing window is displayed in the work area and a waveform is displayed.

£When a .WAV file is read, actually a new .OPL file is created with initial values of the wave parameters that
correspond to the wave file. Therefore, the original .WAV file remains unchanged, and editing will be performed on
duplicate.

£When a .OMP file is read, the Mapping window appears and the list for downloading appears. For details, see
page 59.
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Editing in the Waveform Editing Window

You can use SampleEdit to edit a waveform in the same way you would use word-processing
software to edit a document: for example, you can use the commands [Copy], [Cut], or [Paste].
First you select the waveform area that you want to edit, then you execute various commands
to affect that area.

� Selecting the Area to Be Edited
To select a specific area of the displayed waveform, drag the mouse pointer through the area
to be selected.

1. Move the cursor to a point on the waveform. Press the mouse button at the start point of
the area that you want to edit.

2. Drag to the right, and release the mouse button at the end point of the area that you want
to edit. The selected area is displayed in reverse video (highlighted). The Region box in
the status bar displays the sampling number, from the beginning, for both the start point
and end point of the selected area.

£To select the entire waveform, double click on part of the waveform, or choose [Select All] from the [Edit]
menu.

£To increase or decrease the selected area, press and hold the <Shift> key and click in any location. The
selected area increases or decreases to the clicked location.
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Editing Commands

You can use the [Edit] pulldown menu to simply cut undesired parts from a waveform, or to
insert some part into a different location.

1. To select the waveform area that you want to edit, drag the mouse pointer through the
desired area. The selected area is displayed in reverse video.

2. Choose [Cut] or [Copy] from the [Edit] menu.

Cut:
Choosing [Cut] copies the selected area to the clipboard and deletes the selected area
from the window.

Copy:
Choosing [Copy] copies the selected area to the clipboard, but does not affect the selected
area in the window.

3. To set the location where the data is to be pasted, click at that location.

4. Choose [Paste] from the [Edit] menu. The data in the clipboard is pasted to the designated
location. The data that was at the insertion location moves to the right to accommodate
the new data.

£You can also paste the clipboard data to another currently activated wave file. In this case, the data in the
source file such as bit length and sampling frequency will be replaced by the one in the destination file.

£If you make a mistake while editing, you can undo the mistake. To undo the most recent editing operation,
choose [Undo] from the [Edit] menu.

Editing Effects

You can use the [Effect] menu to process the waveform itself. For example, you can reverse
the selected area of a waveform, which produces the same effect as playing a tape backwards.
You can also invert the top and bottom of a waveform.

1. Select the waveform area that you want to edit. To select the area, drag the mouse pointer
through the desired area. The selected area is displayed in reverse video.

2. Choose the desired command from the [Effect] menu.

£For details on the [Effect] menu, see page 47.

If you make a mistake while editing, you can undo the mistake. To undo the most recent
editing operation, choose [Undo] from the [Edit] menu.
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Zoom Function

You can use the [Zoom] menu to magnify the waveform to make it easier to see, or to quickly
display the entire waveform.

1. Select the waveform area that you want to magnify. To select the area, drag the mouse
pointer through the desired area. The selected area is displayed in reverse video.

2. Choose [Zoom In] from the [Zoom] menu. The selected area is magnified.

£The percentage of magnification depends on the size of the selected area.

£To display the size before the zoom-in, choose [Zoom Out] from the [Zoom] menu. To display the entire
waveform, choose [Unzoom] from the [Zoom] menu.

Waveform Audition

Click the [Start] button in the toolbar to play the wave data to be edited. Click the [Stop] button
to stop playing the wave data.

£Concerning the MIDI channel, velocity, transpose, and program change number items set in the [MIDI] menu
take effect. For details on the [MIDI] menu, see page 44.

£By clicking on the MIDI soft keyboard, you can audition the sound on a musical scale. For details, see page 57.

£When you click the [Start] button, sound is produced by downloading the wave data to the RAM of the internal
tone generator (OPL4). If data of an OMP file was previously downloaded into the RAM, that previously downloaded
data is erased. If you want to replay the erased data, download the data into the RAM again.
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Setting the Loop Point

The loop function enables you to repeatedly play a part of a waveform between two points.
You can use the loop function to produce sound as a musical instrument by continuously
playing short wave data.
You can set the start point at any desired location. The end point is always fixed at the end of
the data.

1. Move the mouse cursor to the desired loop start point on the waveform.

2. Click the right mouse button. The loop start point is set. The loop start point is indicated by
a triangle (the loop pointer). The Loop box in the status bar displays the sampling number
from the beginning of the waveform.

£The loop start point must be set at one or more samplings from the beginning of the waveform. The size of the
loop from the loop start point to the end point of the waveform must be 1992 samplings or more. The initial value of the
loop start point is set at 1 sampling.

Setting Parameters for the Internal Tone Generator (OPL4)

You can control various parameters, such as LFO and envelope settings, that are indispensable
to wave editing.

1. Click the [Parameters] menu. The Parameters dialog box appears.

2. Set the desired parameters in the Envelope, Common, and Effects boxes.

£For details on each parameter, see page 48.

3. Click [OK] to apply the settings.

Loop
Loop pointer

Loop display
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The MIDI Soft Keyboard

The MIDI soft keyboard simulates a MIDI keyboard controller. As with an ordinary MIDI keyboard,
you need to set the MIDI send channels before using the MIDI soft keyboard. The MIDI soft
keyboard is convenient because it enables you to easily play the keyboard in order to audition
sounds (for example, when editing wave data) without connecting an external MIDI keyboard.

£You can use the MIDI soft keyboard to play the internal generators or wave data in accordance with the MIDI
parameter settings, regardless of the wave editing window or the Mapping window.

1. Click the [Keyboard] menu. The MIDI soft keyboard appears.

2. Press (without releasing) the mouse button on the keyboard. You can hear the wave data
being edited or a synthesizer (AWM or FM) sound.
When you click on the MIDI soft keyboard while it is active, the note name of the
corresponding pitch is displayed in the Note box in the status bar.

          

£The items set in the [MIDI] menu for the MIDI channels, velocity, transpose and program change numbers
take effect.

£You can choose the tone generator (RAM, AWM, or FM) that is to produce the sound or change the
volume balance between RAM/AWM and FM in the OPL4 Drive Panel. For more information on the OPL4 Drive
Panel, see pages 14 and 42.

Setting MIDI Parameters

When you use the MIDI soft keyboard, you need to set MIDI parameters, such as the MIDI
channel or the velocity, as you would when using a normal external MIDI keyboard.

You can set the parameters by the following procedure. While the MIDI Soft Keyboard window
is active, click [Instrument] from the [MIDI] menu. Choose the program change number that
you want to sound (instrument voice and wave data). Also use [Parameters] to set values,
such as for the MIDI send channel and the velocity. For details, see page 45.
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Saving Wave Files

After editing in the waveform editing window, you can save the file in the .OPL format.

£Using SampleEdit, you can assign .OPL files to the program change numbers in the Mapping window, and
download the wave files to the RAM, and use them for sequencer playback.

1. While the waveform editing window is active, choose [Save As] from the [File] menu. The
Save As dialog box appears.

2. Select the .OPL file format from the lower left list box.

3. Type a new filename (for example, NEWSOUND) in the File Name box. Click [OK] or
press the <Enter> key. The new .OPL file is saved on the hard disk.

£When the typed filename is the same as a file already on the hard disk, a dialog box appears asking if you want
to overwrite the file on the hard disk. Click [YES] to overwrite the original file and replace it with the new file. Click [NO]
if you do not want to overwrite the original file.

Operations in the Mapping Window

You can create a .OMP file by assigning the .OPL files to each program change number in the
Mapping window. This enables the edited wave data to be downloaded to RAM and used as a
tone generator for musical performance by a sequencer.

� About Downloading
Downloading, in this case, is writing the wave file data (.OMP file) into the RAM mounted on
the sound card.
Once the .OMP file is downloaded it will be memorized until another wave data is downloaded.
The downloading function lets you create your own wave table by combining wave data (RAM)
and AWM/FM sounds.

� Downloading Procedure
The basic downloading procedure is as follows:

1 Open the .OMP file.

2 Create a .OMP file by assigning each .OPL file to patch numbers from 1 to 128.

3 Download the file.
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Opening a .OMP File

Downloading requires a .OMP file. You can make a new .OMP file or read an existing .OMP
file.

£The .OMP file consists of the listed .OPL files. So to make a .OMP file, first create various types of .OPL files
in the waveform editing window, then save them on the hard disk beforehand.

1. Choose [Open] from the [File] menu. The File Open dialog box appears.

2. Select the desired .OMP file. Click [OK]. A Mapping window appears (an example is shown
below).

When creating a new .OMP file, choose [New .OMP] from the [File] menu. The new Mapping
window without any .OPL files appears.

1 Inst. (Instrument/Patch):
Patch numbers from 1 to 128. Each patch number from 1 to 128 corresponds to a program
change number from 0 to 127.

2 OPL File name:
Displays the full pathname, which consists of the assigned .OPL filename and directories.
When no .OPL file is assigned, <None> is displayed.

3 Audition:
While clicking and holding down this button, plays the currently assigned .OPL file. Produces
sound in pitch C3 in accordance with the settings of with [Parameters] in the [MIDI] menu.

4 Size:
Displays the size (in Bytes) of the currently assigned .OPL file. The maximum size of a file
that can be downloaded is 64KB for one waveform. (With the settings monaural sampling,
8 bits and 11.025kHz, you can sample about 6 seconds.)

5 Scrollbar:
Enables scrolling through the patch numbers to 128. The window displays 6 patches at
one time.

6 Download:
Downloads the .OPL file assigned in the list to RAM.

7 Update:
After original data is downloaded, you may want to produce new data by editing the file in
the waveform editing window without closing this Mapping window and download it. The
[Update] button downloads the new data.

8 Free RAM:
Displays the current amount (in Bytes) of free RAM. The total amount of RAM is 128KB
(1KB=1024Bytes).

6 7 2 8

5

4

3

1
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Assigning OPL Files to Patch Numbers

In the Mapping window, you can assign up to 128 .OPL files to patch numbers as far as free
RAM is available and download them.

1. Click the OPL File name box that corresponds to the number of the patch you want to
assign. A .OPL Wave File List dialog box appears (an example is shown below).

2. Select the .OPL file that you want to assign to the patch number. Click [OK]. The selected
.OPL file is assigned, and the full pathname (filename and directories) is displayed.

£To delete an already selected file from the dialog box, click the [No select] button.

3. Repeat the above steps 1 and 2 to assign all the necessary .OPL files to desired patch
numbers.

Downloading

After assigning the .OPL files to patch numbers, click the [Download] button in the Mapping
window. The data is downloaded to RAM.

Saving .OMP Files

You can save the .OPL file assignment list in the Mapping window as a .OMP file. If you make
a .OMP file, it is convenient to use such a set of wave data as a tone generator—you need only
open the file and then download it.
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About Sample Files

The accompanying sample files which are automatically placed in the \YAMAHA\DATA directory,
contain various types of .OPL and .OMP files. You can select them by opening the File Selection
dialog box using the file [Open] command from the [File] menu, and designating the
\YAMAHA\DATA directory.

¢When a directory other than the C:\YAMAHA\DATA is specified, the .OMP files will not function properly.
The .OMP files are configured to assume a standard Sound Edge installation on the C drive, so if you have installed
Sound Edge in a different directory or drive, you will have to modify the data in the .OMP files.

� Sample File List

.OPL Files

File Name Contents

b_slide.opl Sound of an electric bass sliding down.

car_engn.opl Sounds like a car engine starting.

cough.opl Sound of a snare drum in which the pitch of the decay is rising.

cut_noiz.opl Sound of the cutting noise of brushing of an electric guitar.

dog.opl Sound of a dog barking.

footstep.opl Sound of human footsteps.

growl.opl Sound of a lion growling.

heart.opl Sound of a heart beat.

horse.opl Sound of a horse galloping.

joker.opl Sound effects useful as drum part breaks or fill-ins.

kitty.opl Sound of a depressing kitty call.

klang.opl Metallic sound of a drum.

laughing.opl Sound of a man laughing.

mcin_gun.opl Sound of a machine gun firing.

mello.opl Sounds constructed from a diminished arpeggio.

oildr.opl Sounds like the bottom of an oil drum being beaten.

orexk.opl Metallic sound of a snare drum.

File Name Contents

p_scrape.opl Sound of a distorted guitar scratch noise.

punch.opl Sound of a punch.

r2d2.opl Sounds like a robot talking.

rezzo.opl Electric sounds.

robot.opl Sounds like a robot.

ruff.opl Sound effect useful as accents to a snare drum.

s1.mth.opl Funky image sound.

s2.mth.opl Sound effect useful for rap music.

scream.opl Sound of a woman screaming.

stab.opl Sounds like some strong metallic object.

sword.opl Sounds like a Japanese sword slicing through air.

tape.opl Sounds like an open reel tape being wound, slowing, then stopping.

tel_dial.opl Sound of a telephone ringing.

type.opl Sound of typing a typewriter.

ugly.opl Sound having a strong attack.

wet.opl Strange sound?

xplosion.opl Sound of an explosion.

.OMP Files

ANIMALS.OMP
1 HORSE.OPL

2 KITTY.OPL

3 DOG.OPL

4 GROWL.OPL

ANY_WAY.OMP
1 COUGH.OPL

2 OILDR.OPL

3 OREXK.OPL

4 TAPE.OPL

5 UGLY.OPL

6 TYPE.OPL

QUEER_KT.OMP
1 KLANG.OPL

2 S1-MTH.OPL

3 S2-MTH.OPL

4 JOKER.OPL

5 RUFF.OPL

6 SWORD.OPL

ROBOTICS.OMP
1 R2D2.OPL

2 MELLO.OPL

3 ROBOT.OPL

4 REZZO.OPL

5 STAB.OPL

6 WET.OPL

BRUTE.OMP
1 HEART.OPL

2 SCREAM.OPL

3 MCIN_GUN.OPL

4 PUNCH.OPL

5 LAUGHING.OPL

6 XPLOSION.OPL

JARRING.OMP
1 B_SLIDE.OPL

2 CUT_NOIZ.OPL

3 P_SCRAPE.OPL
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Error Messages

An unexpected error occurred while
reading [pathname].

Displayed when the file with the specified pathname
cannot be read. Specify the correct pathname.

An unexpected error occurred while
writing [Pathname].

Displayed when the file with the specified pathname
cannot be saved. Specify the correct pathname.

Cannot find OPL4 RAM!

Displayed when attempting to start SampleEdit while
the RAM is not properly set .

Cannot open more .OMP files.

Displayed when attempting to open another .OMP
file while several .OMP files are open.

Failed to create empty document.

Displayed when an attempt to create a new .OMP
file fails.

Failed to open document.

Displayed when an attempt to open a file fails.

Instrument No [Inst no] is changed from
[pathname] into [No Select].

Displayed when a .OPL file has been deleted or
moved to another directory after the .OPL file was
assigned in the Mapping window.

Loop size of [pathname] too small!

Displayed when an attempt is made to download data
with a loop size that is too small.

Loop size too small!

Displayed when the loop size is smaller than 1992
samplings during an attempt to set a loop start point.
Set the loop start point so that it is 1922 or more
samplings.

OPL4 WAVE RAM overflow!

Displayed when not enough RAM memory is available
during an attempt to do one of the following: Play
wave data with the MIDI soft keyboard or Play button;
assign a .OPL file in the Mapping window; click the
[Download] button.

Out of memory!

Displayed when not enough memory could be
reserved during an attempt to do one of the following:
open a file; execute [Cut], [Undo], or [Paste] from the
[Edit] menu; play wave data with the MIDI soft
keyboard or Play button; or click the [Download]
button.

[Pathname] wave data size too big!

Displayed when the wave data is bigger than 64KB
during an attempt to do one of the following: play wave
data with the MIDI soft keyboard or Play button; assign
a .OPL file in the Mapping window; or click the
[Update] button.

SampleEdit needs YAMAHA OPL4 Driver!

Displayed when attempting to start SampleEdit while
the YAMAHA OPL4 Driver is not properly set. For
details on installing the YAMAHA OPL4 Driver, see
page 14.

Select OPL file!

Displayed when a non-OPL file is selected while
assigning a file in the Mapping window.

Unexpected file format.

Displayed when specifying a pathname SampleEdit
does not support, and attempting to open it.
SampleEdit can read three types of files: .OPL, .WAV,
and .OMP. SampleEdit is compatible with the
following wave data: 8 or 16 bit; 11.015, 22.050 or
44.1kHz sampling; monaural. Any file with a different
format cannot be read.

Wave data size too big!
OPL max data size 65536 bytes.
Save anyway?

Displayed when the data size is too big during an
attempt to save a file.
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DOS APPLICATIONS
You can use the KPCON and KPLOAD commands to control the DSP from DOS.

* The symbol “_” indicates a space in a command.

KPCON
KPCON lets you control the DSP from the DOS command line. (KPCON’s function is similar to EffectEdit in
Windows.)

Startup Procedure

Start KPCON in the YAMAHA directory.

[KEY OPERATION]

CD_\YAMAHA + <ENTER>

KPCON + <ENTER>

A list of commands will appear on screen.
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Operation

The following key operation will show the syntax for commands that allow you to control the
DSP effects.

[KEY OPERATION]
KPCON_/__________  (long underline indicates command name)

Control the KPCON with the following commands.

COMMAND CONTENTS

q u i e t Suppresses configuration messages usually displayed
whenever you execute a command.

t y p e : [ X ] Changes the DSP type. Valid values are 0~3.

t [ x ] d i r : [ y ] Right channel digital input volume.

t [ x ] d i l : [ y ] Left channel digital input volume.

t [ x ] a i r : [ y ] Right channel analog input volume.

t [ x ] a i l : [ y ] Left channel analog input volume.

t [ x ] m i c : [ y ] Microphone input volume.

t [ x ] a o r : [ y ] Right channel analog output volume.

t [ x ] a o l : [ y ] Left channel analog output volume.

£Parameters include [x] as the effect program type (values are 0~3), and [y] as the volume value (values are
-4095 ~ 4095).

COMMAND CONTENTS

t [ x ] v c l : [ y ] Executes Voice Cancel.
X=Type0~2; y=0 (off), 1 (on)

t [ x ] k c l : [ y ] Executes Key Control.
X=Type0~1; y=Pitch -4095 ~ 4095.

t [ x ] d p t : [ y ] Determines delay volume.
X=Type0~3; y=Volume -4095 ~ 4095.

t [ x ] f b l : [ y ] Determines delay feedback volume.
X=Type0~3; y=Volume -4095 ~ 4095.
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KPLOAD
The KPLOAD command lets you use the effects with DOS, which functions similar to EffectGear in Windows.
You can use KPLOAD with KPCON for precise setups.

Startup Procedure

Access the KP directory by typing the following command on the DOS command line.

[KEY OPERATION]
CD_\YAMAHA

Operation

Type in the following command on the DOS command line.

[KEY OPERATION]
KPLOAD_DATA\______.MBJ (long underline indicates the .MBJ file name)

You can check the effect type by moving to the DATA directory, then using the DIR command.

[KEY OPERATION]
CD_\YAMAHA\DATA+ <ENTER>
DIR_/W+ <ENTER>
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APPENDIX

Configuration Setup
Yamaha Sound Edge is installed with certain default settings; however, some computers may not execute
the functions properly. Therefore, you may need to adjust your computer’s configuration using the Opti
M16INIT program. This will allow you to set the configuration of the Digital Sound Controller Opti 82C928
built into the Sound Edge’s sound card.

M16INIT

Startup Procedure

Move to the \MAD16 directory, then start M16INIT.

[KEY OPERATION]

CD_\YAMAHA\MAD16 + <ENTER>
M16INIT + <ENTER>

The following screen appears.

[KEY OPERATION]
Use the <↑>/<↓> keys to select a menu.
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Configuration Setup

[KEY OPERATION]
Select [Configure], then press <ENTER>.
The Configuration setup window appears.

[KEY OPERATION]
Use the cursor keys to select an item, then press <ENTER> or <SPACE BAR> to execute the
selection. Press the <ESC> key to exit the Configuration window.

1

       ITEM CONTENTS DEFAULT

Mode Choose either SB (SoundBlaster) or SB
WSS (Windows Sound System)

Port Address Set port address 220

IRQ Number Select interrupt request number 5

DMA Channel Select channel 1

CD-ROM Interface Enables CD-ROM function Disable

CD-ROM Models Select CD-ROM type (select one to Sony/
activate the setup window) Panasonic

Game Port Enables Joystick port function Disable

Input Source Select MIC or LINE input MIC

Port:
The I/O (Input/Output) port facilitates transmission and reception of computer data between the CPU and external
devices. The CPU determines the setup address of the sound card using this port. You cannot select an address for a
device if you have already assigned that address to other devices.

IRQ:
The IRQ (Interrupt Request) number allows external devices to transmit or receive data by priority, according to the IRQ
number assigned to each external device, while the CPU is processing data. The lower the IRQ number, the higher the
data processing priority.
Please take care in advance when assigning IRQ numbers to each device in order to avoid data processing conflicts.

DMA:
DMA (Direct Memory Access) is the communication protocol between internal memory and external devices that minimizes
the work of the CPU. As with the IRQ number, you cannot select an active channel.

1

2
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2

[OK] Applies the modified settings

[Load] Loads the configuration file

[Save] Saves the configuration file

[Volume] Sets the sound card’s volume

[Cancel] Cancels the modified settings

When you select [Volume], the VOLUME SETTINGS dialog box setup screen appears.

You can assign different output level settings independently for each input source.
Use the <←><→> keys to select a channel and the <↑>/<↓> keys to set the volume, then
press <ENTER> to execute. Press the <ESC> key to exit from the VOLUME SETTINGS dialog
box.

•VOLUME SETTINGS

MASTER
Sets the left and right overall output volume levels independently.

VOICE
Sets the WAV file left and right output volume levels independently.

MUSIC
Sets the MIDI file (synthesizer) left and right output volume levels independently.

CD AUDIO
Sets the CD-ROM left and right line-level output volume levels independently.



69

Appendix

Sound Test

If the configuration setup is completed correctly, you should be able to hear the sound test.

[KEY OPERATION]
Select [Sound Test], then press <ENTER>.

If you cannot hear any sound in the Sound Test, return to the Configuration screen and configure
the setup once again.

Quit Test

To exit M16INIT.

[KEY OPERATION]
Select [Quit Test], then press <ENTER> to exit M16INIT.

Initialization

In case the Sound Edge does not execute or produce sound properly, you may want to
initialize the Opti 82C928.

On the DOS command line, execute the command M16INIT /B to initialize Opti 82C928.
The screen below will appear.

[KEY OPERATION]

CD_\YAMAHA\MAD16 + <ENTER>
M16INIT_/B + <ENTER>
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CD-ROM INSTALLATION
The Yamaha Sound Edge SW20 has a CD-ROM connector and includes an interface which lets you set up
a CD-ROM player without a CD-ROM interface card.

Compatible CD-ROMs

The following types of CD-ROMs can be used.

Panasonic/Creative: CR 562B/563
Sony: CDU 31A/33A
Mitsumi: CRMC LU005S, CRMC FX001/001D

CD-ROM Connection

Connect your CD-ROM drive to the Sound Edge SW20 as shown below.

CD-ROM connector: To connect the CD-ROM.

CD IN connector: To connect the audio from the CD-ROM.

Please note that the CD-ROM connector and the CD IN connector port varies depending upon
the type of CD-ROM player you use, so take care that your CD-ROM is connected properly.

PANASONIC CD IN connector

MITSUMI CD IN connector

SONY CD IN connector

PANASONIC CD-ROM connector

MITSUMI CD-ROM connector

SONY CD-ROM connector
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CD-ROM Setup

Driver Setup
You can use the floppy disks included with your CD-ROM player to set up the driver. (You will
need to set up MSCDEX.EXE and an ISA CD-ROM Device Driver.) Refer to your CD-ROM
owner’s manual for the proper procedure for setting up the driver.

¢If you have been using SoundBlaster and have a Panasonic/Creative CD-ROM player, you must delete
/SBP:220  from the CD-ROM Device Driver Setup Line in the CONFIG.SYS file.

CDSETUP.SYS Setup
The CD-ROM setup device driver (CDSETUP.SYS) enables you to use a CD-ROM with the
Sound Edge SW20.
You are required to set the configuration to run the CD-ROM with the Sound Edge SW20 after
you have properly connected the CD-ROM.

1. Start M16INIT. (For details, see Sound Edge Configuration Setup, page 66.).

2. Select [Configure], then press <Enter>.

3. Use the <→> key to move the cursor of the CD-ROM Interface to [Enable], then press
<Enter>.

4. Next, use the <→> key to move to [CD-ROM Models], which displays the names of CD-
ROM makers. Select the maker and press <Enter>. The appropriate CD-ROM setup window
appears.

5. Use the <→> key to move among items to select the setup you desire. Press the <Enter>
key to execute the setup, then click [OK] to complete the setup.

In general you should leave the default settings of the CD-ROM setup window as they are.
However, if you have a conflict problem with another card such as a video card interfering
with the IRQ and DMA (DRQ) settings, you will need to modify the CD-ROM configuration
setup to correct the problem.

£About the default settings:
The default setting for Mitsumi IRQ is 10, DMA is set to Disable; for Panasonic and Sony, IRQ and DMA are both set to
Disable.
¢For the CD-ROM setup, do not use DMA; leave it disabled.

¢When changing the PORT ADRESS (CD BASE) on the Panasonic, do not select 360.

The next line will be added to the CONFIG.SYS file as a result of the CD-ROM setup.

Example: For Panasonic

DEVICE=C:\YAMAHA\MAD16\CDSETUP.SYS/T:P/P:340

RESTART
When you have completed the entire setup procedure, restart your system.
This is all there is to the CD-ROM setup. Your computer will apply your new settings automatically
so you can use the CD-ROM.
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TROUBLESHOOTING

DOS does not start or run properly.

• Reset your computer. (If it still acts improperly, check your system; see below.)
• Check the AUTOEXEC.BAT file to see if the Yamaha information is correct. If something is incorrect,
edit the AUTOEXEC.BAT file (see page 13) and correct the information using editor software, etc.
• Check the CONFIG.SYS file. If necessary, set the configuration so that it matches your system, or
reinstall the software. If everything looks OK, remove unnecessary drivers in the CONFIG.SYS file, then
restart your computer.

Windows will not start.

• The sound card may not be inserted properly into the expansion slot. Check it or insert the sound card
into another expansion slot and try again.
• May not be enough memory to start Windows. (Start Windows in standard mode by typing WIN2/S at
the DOS prompt.) If Windows starts properly, the driver setup may still remain in your system. Check the
contents of SYSTEM.INI. (See page 13.)

No sound

• Check the Mute setting for the [MAD16C.DRV] section in the Windows SYSTEM.INI file. If Yes is
selected, no sound will be produced. Change the setting to No.

FM does not sound.

• Check settings of your game application. If it is set correctly, try activating the M16INIT to initialize it,
and then check your setup accordingly. (See page 69.)

MIDI (internal synthesizer) does not sound.

• YAMAHA OPL4 Driver may not be selected as the MIDI output port. Start MIDI Orchestrator Plus, open
the MIDI Port Setup dialog box by clicking [MIDI Port Setup] in the [Options] menu, and select [YAMAHA
OPL4 Driver] for the MIDI output port.
• Check if EffectGear’s [Volume] slider is set to minimum, thus preventing sound output.

Game does not respond.

• If the DOS program is running properly but the game does not respond, there may be a conventional
memory problem (DOS can only manage memory up to a maximum of 640KB). Remove any unnecessary
drivers not used by CONFIG.SYS, or activate the game disk by creating a Startup disk for the game.
Remember to add the additional Yamaha information in the AUTOEXEC.BAT file to the disk.

Wave file will not sound.

• Check whether the AudioStation’s WAV fader is turned down, thereby preventing sound output.
• Execute M16INIT2/B command. (See page 69.)

Digital audio sound problems.

• The DMA contains “Demand Mode DMA” and “Single Mode DMA”, and is normally set to Demand
Mode DMA to enable effective communication between internal memory and external devices. If your
computer does not support Demand Mode DMA, it may not be able to properly play back WAV files using
AudioStation and other products, and you must therefore use Single Mode DMA. In this case, select
[YAMAHA Audio Device Driver] in the [Driver] (Control Panel), and click [Setup] to open the YAMAHA
Sound Driver Setup window. Click [Advanced Settings] to open the Advanced Settings window. In
[Advanced Settings], mark an (x) in the check box of [Use Single Mode DMA] and change the [DMA
buffer size] (which determines how much data will be transferred at one time between internal memory
and external devices) if necessary. If the [DMA buffer size] is assigned enough memory, data transfer
will be faster; however, it will require a considerable amount of memory. The default setting is 32KB. To
modify the setting, set the memory size by multiples of 4 (e.g., 28KB, 36KB, etc.).
• Some computers have a built-in sound system. If your computer does, be sure to turn it off.
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PATCH (Instrument) LIST (GM VOICE MAP)

Category No. Patch Name
Piano   1 Acoustic Grand Piano

  2 Bright Acoustic Piano
  3 Electric Grand Piano
  4 Honky-tonk Piano
  5 Electric Piano 1
  6 Electric Piano 2
  7 Harpsichord
  8 Clavi

Chromatic Percussion   9 Celesta
10 Glockenspiel
11 Music Box
12 Vibraphone
13 Marimba
14 Xylophone
15 Tubular Bells
16 Dulcimer

Organ 17 Drawbar Organ
18 Percussive Organ
19 Rock Organ
20 Church Organ
21 Reed Organ
22 Accordion
23 Harmonica
24 Tango Accordion

Guitar 25 Acoustic Guitar (nylon)
26 Acoustic Guitar (steel)
27 Electric Guitar (jazz)
28 Electric Guitar (clean)
29 Electric Guitar (muted)
30 Overdriven Guitar
31 Distortion Guitar
32 Guitar Harmonics

Bass 33 Acoustic Bass
34 Electric Bass (finger)
35 Electric Bass (pick)
36 Fretless Bass
37 Slap Bass 1
38 Slap Bass 2
39 Synth Bass 1
40 Synth Bass 2

Strings 41 Violin
42 Viola
43 Cello
44 Contrabass
45 Tremolo Strings
46 Pizzicato Strings
47 Orchestral Harp
48 Timpani

Ensemble 49 String Ensemble 1
50 String Ensemble 2
51 Synth Strings 1
52 Synth Strings 2
53 Choir Aahs
54 Voice Oohs
55 Synth Voice
56 Orchestra Hit

Brass 57 Trumpet
58 Trombone
59 Tuba
60 Muted Trumpet
61 French Horn
62 Brass Section
63 Synth Brass 1
64 Synth Brass 2

Category No. Patch Name
Reed 65 Soprano Sax

66 Alto Sax
67 Tenor Sax
68 Baritone Sax
69 Oboe
70 English Horn
71 Bassoon
72 Clarinet

Pipe 73 Piccolo
74 Flute
75 Recorder
76 Pan Flute
77 Blown Bottle
78 Shakuhachi
79 Whistle
80 Ocarina

Synth Lead 81 Lead 1 (square)
82 Lead 2 (sawtooth)
83 Lead 3 (calliope)
84 Lead 4 (chiff)
85 Lead 5 (charang)
86 Lead 6 (voice)
87 Lead 7 (fifth)
88 Lead 8 (bass+lead)

Synth Pad 89 Pad 1 (new age)
90 Pad 2 (warm)
91 Pad 3 (polysynth)
92 Pad 4 (choir)
93 Pad 5 (bowed)
94 Pad 6 (metallic)
95 Pad 7 (halo)
96 Pad 8 (sweep)

Synth Effects 97 FX 1 (rain)
98 FX 2 (soundtrack)
99 FX 3 (crystal)
100 FX 4 (atmosphere)
101 FX 5 (brightness)
102 FX 6 (goblins)
103 FX 7 (echoes)
104 FX 8 (sci-fi)

Ethnic 105 Sitar
106 Banjo
107 Shamisen
108 Koto
109 Kalimba
110 Bagpipe
111 Fiddle
112 Shanai

Percussive 113 Tinkle Bell
114 Agogo
115 Steel Drums
116 Woodblock
117 Taiko Drum
118 Melodic Tom
119 Synth Drum
120 Reverse Cymbal

Sound Effects 121 Guitar Fret Noise
122 Breath Noise
123 Seashore
124 Bird Tweet
125 Telephone Ring
126 Helicopter
127 Applause
128 Gunshot
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DRUM KEY ASSIGN LIST
  Program No.

1 9 17 25 26 33 41 49

No. YAMAHA Voyetra Key Off Alternate Standard Room Rock Electric Analog Jazz Brush Classic
Note name Note name

23 B -1 B1 Click L

24 C 0 C2 Click R

25 C#0 C#2 Brush Tap

26 D 0 D 2   ○ Brush Swirl L

27 D#0 D#2 Brush Slap

28 E 0 E 2   ○ Brush Swirl H Reverse Cymbal Reverse Cymbal

29 F 0 F2   ○ Snare Roll

30 F#0 F#2 Castanet Hi Q Hi Q

31 G 0 G2 Snare L SD Power M Snare M SD Power H Brush Slap L

32 G#0 G#2 Sticks

33 A 0 A2 Bass Drum L Bass Drum M Bass Drum H Bass Drum M

34 A#0 A#2 Open Rim Shot

35 B 0 B2 Bass Drum M Bass Drum H BD Power BD Analog L

36 C 1 C3 Bass Drum H BD Power BD Gate BD Analog H Gran Cassa

37 C#1 C#3 Side Stick Analog Side Stick

38 D 1 D3 Snare M SD Rock SD Power L Analog Snare L Brush Slap

39 D#1 D#3 Hand Clap

40 E 1 E3 Snare H SD Power Rim SD Power H Analog Snare H Brush Tap

41 F 1 F3 Floor Tom L Room Tom 1 Power Tom 1 E Tom 1 Analog Tom 1 Jazz Tom 1 Brush Tom 1 Jazz Tom 1

42 F#1 F#3      1 Closed Hi-Hat Analog HH Closed 1

43 G 1 G3 Floor Tom H Room Tom 2 Power Tom 2 E Tom 2 Analog Tom 2 Jazz Tom 2 Brush Tom 2 Jazz Tom 2

44 G#1 G#3      1 Pedal Hi-Hat Analog HH Closed 2

45 A 1 A3 Low Tom Room Tom 3 Power Tom 3 E Tom 3 Analog Tom 3 Jazz Tom 3 Brush Tom 3 Jazz Tom 3

46 A#1 A#3      1 Open Hi-Hat Analog HH Open

47 B 1 B3 Mid Tom L Room Tom 4 Power Tom 4 E Tom 4 Analog Tom 4 Jazz Tom 4 Brush Tom 4 Jazz Tom 4

48 C 2 C4 Mid Tom H Room Tom 5 Power Tom 5 E Tom 5 Analog Tom 5 Jazz Tom 5 Brush Tom 5 Jazz Tom 5

49 C#2 C#4 Crash Cymbal 1 Hand Cym. Open L

50 D 2 D4 High Tom Room Tom 6 Power Tom 6 E Tom 6 Analog Tom 6 Jazz Tom 6 Brush Tom 6 Jazz Tom 6

51 D#2 D#4 Ride Cymbal 1 Hand Cym.Closed L

52 E 2 E4 Chinese Cymbal

53 F 2 F4 Ride Cymbal Cup

54 F#2 F#4 Tambourine

55 G 2 G4 Splash Cymbal

56 G#2 G#4 Cowbell

57 A 2 A4 Crash Cymbal 2 Hand Cym.Open H

58 A#2 A#4 Vibraslap

59 B 2 B4 Ride Cymbal 2 Hand Cym.Closed H

60 C 3 C5 Bongo H

61 C#3 C#5 Bongo L

62 D 3 D5 Conga H Mute Analog Conga H

63 D#3 D#5 Conga H Open Analog Conga M

64 E 3 E5 Conga L Analog Conga L

65 F 3 F5 Timbale H

66 F#3 F#5 Timbale L

67 G 3 G5 High Agogo

68 G#3 G#5 Low Agogo

69 A 3 A5 Cabassa

70 A#3 A#5 Maracas

71 B 3 B5   ○ Samba Whistle H

72 C 4 C6   ○ Samba Whistle L

73 C#4 C#6 Guiro Short

74 D 4 D6 Guiro Long

75 D#4 D#6 Claves

76 E 4 E6 Wood Block H

77 F 4 F6 Wood Block L

78 F#4 F#6 Cuica Mute Scratch Push Scratch Push

79 G 4 G6 Cuica Open Scratch Pull Scratch Pull

80 G#4 G#6      2 Triangle Mute

81 A 4 A6      2 Triangle Open

82 A#4 A#6 Shaker

83 B 4 B6 Jingle Bell

84 C 5 C7 Bell Tree

85 C#5 C#7 Hi Q

* Alternates within the same group (group 1, 2) cannot sound at the same time. You can create realistic live drummer effects by using #42 Closed Hi-hat to effectively “cut

off” #46 Open Hi-hat.

* There are two different types of note names, one which Yamaha uses and one which Voyetra uses. When running MIDI Orchestrator Plus, refer to the Voyetra note

names.
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SPECIFICATIONS
Minimum System Requirements

Computer (PC/AT compatible) CPU: 80486/25MHz or higher

Memory: 8MB of system memory or higher

16-bit ISA internal slot

Monitor Color or gray scale VGA or Super VGA compatible

External Devices Mouse, hard disk and audio speakers or headphones

OS DOS Ver 5.0 or higher; Windows 3.1 or higher

Synthesizer Module
Yamaha OPL4 (YMF278B-F) Preset Voices: 128 instrument voices, 8 drum sets

Polyphony: 24-note (AWM wave table), 20-note (2-operator FM)

Multi-timbral Capacity: 16 voices simultaneously

Wave ROM 2MB

Wave RAM 128KB

Compatibility
Sound Module Mode GM SYSTEM LEVEL 1

SoundBlaster Pro or Windows Sound System

Sampling Sound Source
A/D Sampling Rate 5.5125kHz~48kHz

A/D Sampling Resolution 16-bit linear or 8-bit linear

Sampling Source MIC/LINE/CD AUDIO

Effects
Yamaha DSP (YSS205-F) Mic Echo, Surround

Voice Cancel

Key Control (Pitch Change)

Terminals
OUTPUT jack Stereo mini jack; Nominal Output: 760mV r.m.s., Maximum Output: 3.5V

r.m.s. (@4Ω 10%THD)

LINE IN jack Stereo mini jack; Nominal Input: 200mV r.m.s.

MIC IN jack Mono mini jack; Nominal Input: 150mV r.m.s.

MIDI/JOYSTICK connector Dsub-15pin

CD-ROM connector (Recommended CD-ROM drives)

Panasonic/Creative (CR562B/563), 40-pin

Sony (CDU31A/33A), 34-pin

Mitsumi (CRMC LU005S, CRMC FX001/001D), 40-pin

Interfaces MIDI interface (MPU-401 Compatible)

Joystick interface (Supports IBM-standard analog joystick)

AT-BUS CD-ROM interface

Other Specifications
Dimensions (W x D x H) 106 × 255.5 × 15 mm (4-1/5" x 10" x 3/5")

Weight 200g (7 oz.)

Package Contents
Install Disk 1, 2, 3, 4

Sound Card SW20

Microphone

Yamaha Sound Edge Owner’s Manual

Voyetra MIDI Orchestrator Plus/Sound Software User’s Guide

Optional Equipment
Yamaha MIDI Adaptor Cable MDC-01

Specifications subject to change without notice.
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TransmittedFunction... Recognized Remarks

Basic 
Channel

Note 
Number

Velocity

After
Touch

Pitch Bender

Control 
Change

Mode

Default
Changed

Note ON
Note OFF

Key’s
Ch’s

1
7

6, 38
10
11
64

100, 101
120
121

:True voice

×
×�

×
×�

×
×�

×
×
×
×
×
×

×
×�

×
×
＊＊＊＊＊＊＊�

×
＊＊＊＊＊＊＊�

×

1-16
1-16

○ 9nH, v=1-127
×�

×
×�

○
○
○
○
○
○
�
�
○
○
○�

Mode 3
×
×�

0-127
0-127

○ 0-24 semi

Modulation
Volume
Data Entry
Panpot
Expression
Sustain

RPN LSB, MSB
All Sound Off
Reset All Controls

12 bit resolution
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Version: 1.00MIDI Implementation Chart
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Prog
Change

System Exclusive

common

System
Real Time

Aux
Messages

Note:

11
64

100, 101
120
121

:Clock
:Commands

:Local ON/OFF
:All Notes Off
:Active Sense
:Reset

:Song Pos.
:Song Sel.
:Tune

×
×
×

×
×�

×
＊＊＊＊＊＊＊�

×
×
×�

×
×�

×
×
×
×�

×�

Mode 1: OMNI ON, POLY
Mode 3: OMNI OFF, POLY

○
○
○
�
�
○
○
○�

○
0-127

×
×
×�

×
×�

×
○ (123-127)
×
×�

○�

p
Expression
Sustain

RPN LSB, MSB
All Sound Off
Reset All Controls

Program number 1-128

○: YES
×: NO

:True #

Mode 2: OMNI ON, MONO
Mode 4: OMNI OFF, MONO
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CHANNEL MESSAGE (Reception)
NOTE ON/OFF

Note Number C-2–G8

Velocity 1–127

CONTROL CHANGE

(CONTROL NUMBER) (PARAMETER)

                1 Modulation 0–127

                7 Volume 0–127

              10 Panpot 0–127

              11 Expression 0–127

              64 Sustain 0–127

CHANNEL MODE MESSAGE

All SOUND OFF Message allows complete shut off of all sounds; however retains NOTE ON and HOLD ON channel messages.

RESET ALL CONTROLLERS

Reset controller’s value to default (below):

PITCH BEND 0 (CENTER)

CHANNEL PRESSURE 0 (OFF)

MODULATION 0 (OFF)

EXPRESSION 127 (MAX)

HOLD 0 (OFF)

RPN RPN numbers undecided/Internal data will not change.

ALL NOTE OFF Message allows NOTE OFF of all occurring sounds, however when HOLD1 is ON, NOTE OFF will not occur until channel

(HOLD1) turns off.

RPN (Registered Parameter Number)

PITCH BEND SENSITIVITY

BnH, 64H, 00H, 65H, 00H, 06H, mmH

mm:00H–18H (0–24 Semitones)

Default is 02H (2 Semitones)

FINE TUNING

BnH, 64H, 01H, 65H, 00H, 06H, mmH, 26H, llH

mm, ll: (00H, 00H)–(40H, 00H)–(7FH, 7FH)

-100cents     +100cents

COARSE TUNING

BnH, 64H, 01H, 65H, 00H, 06H, mmH

mm:28H  -00H - 58H (-24  -0  -24 Semitones)

NULL

BnH, 64H, 7FH, 65H, 7FH

PROGRAM CHANGE

GM VOICE 0–127–> VOICE1–VOICE128

DRUM SET CAH, xxH

xx:0 Standard

xx:8 Room

xx:10 Power

xx:18 Electronic

xx:19 Analog

xx:20 Jazz

xx:28 Brush

xx:30 Orchestra

Other Ignore

Default: Standard Set

SYSTEM EXCLUSIVE

GM LEVEL 1 SYSTEM ON F0H, 7EH, 7FH,09H, 01H, F7H

Message initializes all controllers to default except MIDI MASTER TUNING.

MIDI MASTER VOLUME F0H, 7FH, 7FH, 04H, 01H, ll, mm, F7H

Message controlls volume on all channels at once.

Default value of mm is 7FH, II is ignored.

MIDI MASTER TUNING F0H, 43H, 1nH, 27H, 30H, 00H, 00H, mm, ll, cc, F7H

Message controls value on all channels at once.

mm II value equal to MIDI MASTER TUNING VALUE.

T=Mx200–256–100

M: 3bit of mm as MSB, 3 bit of II as LSB.

Byte value defined in numerics.

Defaults for mmII are 07H, 0FH.

n, c are optional.

These values will not be initialized even by GM LEVEL 1 SYSTEM ON or RESET ALL CONTROLLERS.
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I NDEX

A
ABOUT button .................................... 19

About DSP Delay, Echo and Surround Effects 23

About Downloading ............................ 58

About Menu ....................................... 25

About SE ........................................... 50

About the default settings ...................... 71

About the MIDI Interface For DOS ......... 16

About the Types of Input Channels ......... 29

About VoiceMorph .............................. 22

ALL ON/OFF ..................................... 14

Apply Echo ........................................ 36

Arrange Icons ..................................... 50

assign instrument ................................. 14

Assigning OPL files .............................. 60

Attack Rate ......................................... 49

Audio Channel ................................... 29

Audition ....................................... 55, 59

Auto Reset .......................................... 14

AUTOEXEC.BAT ................................. 13

B
Balance ....................................... 14, 25

Block Diagram .................................... 26

C
Cancel .............................................. 68

Cascade ........................................... 50

CD AUDIO ........................................ 68

CD IN connector ............................ 5, 70

CD-ROM .......................... 5, 67, 70, 71

CDSETUP.SYS Setup ........................... 71

Ch. (Channel) ..................................... 14

CHANNEL MESSAGE (Reception) ......... 78

Close ................................................ 43

Comand ...................................... 54, 64

Common ...................................... 49, 56

Compatible CD-ROMs ..................... 3, 70

Configuration ..................................... 66

Configuration setup window ................. 67

CONNECTIONS ................................. 4

Contents ...................................... 22, 50

Control .............................................. 22

Control menu box ............................... 29

Control Panel ............................... 14, 22

CONTROL.INI .................................... 13

Copy .......................................... 46, 54

Copy button ....................................... 41

Cut ............................................. 46, 54

Cut button .......................................... 40

D
Decay Rate/Level ............................... 49

Default ............ 6, 10, 14, 16, 45, 67, 71

Delay .......................................... 23, 32

Delay Design Box ................... 31, 32, 33

Depth ................................................ 22

DMA (Direct Memory Access) ............... 67

DMA Channel .................................... 67

Downloading ..................................... 58

Driver Setup ....................................... 71

DRUM KEY ASSIGN LIST ..................... 74

DSP ................................................... 23

E
Echo ................................................. 23

Edit Menu .......................................... 46

Effect Menu ........................................ 47

Effect Programs ................................... 26

Effect(s) ..................... 19, 20, 49, 54, 56

EffectEdit ............................................ 23

EffectGear ......................................... 18

Envelope ...................................... 48, 56

Error Messages ................................... 62

Exit ............................................. 24, 43

Expansion slot .................................. 7, 8

F
Fast Damp ......................................... 14

fc (frequency cutoff) ............................. 31

File List 1, 2, 3, 4 ............................... 43

File Menu .................................... 24, 43

File Open button ................................. 40

Fine Tune ........................................... 49

FM tone generator ........................ 14, 42

Free RAM .......................................... 59

G
Gain/LFO Setup ................................. 22

Game Port ......................................... 67

GM .................................................. 45

GM VOICE MAP ................................ 73

H
H.P.F (High Pass Filter) ......................... 31

Help ................................................. 22

HELP button ........................................ 19

Help Menu ......................................... 50

I
IIR Filter (Infinite Impulse Response Filter) 31, 32, 33

Initialization ........................................ 69

Input .................................................. 33

Input Caption ..................................... 24

Input Mixer ............................. 28, 29, 34

Input Source ....................................... 67

Inst. (Instrument/Patch) ......................... 59

INSTALLATION ................................. 7, 9

Installing for DOS .................................. 9

Installing for Windows ......................... 12

Instrument (Patch) ................................. 44

INTERNAL LINE IN ................................ 6

Internal Tone Generator (OPL4) ............. 56

Inverse ............................................... 47

Inverse button ..................................... 41

IRQ (Interrupt Request) number ..... 5, 6, 16, 67

ITEM ................................................. 67

J
JOYSTICK ............................................ 3

Jumper ............................................. 5, 6

K
Key Control ..................... 26, 28, 32, 35

Key Shift ............................................ 32

Keyboard Menu .................................. 44

.KPE .................................................. 37

L
L.P.F (Low Pass Filter) ........................... 31

LEFT CHANNEL OUTPUT ....................... 6

Level Fader ......................................... 29

LFO (Low Frequency Oscillator) ............. 22

LFO Speed ......................................... 49

LINE .................................................. 19

LINE IN jack ........................................ 5

Line In/Synth (Synthesizer) .................... 21

Load ................................................. 68

Loop ................................................. 56

Loop display/pointer ........................... 56

Loop/Note ........................................ 41

M
M16INIT ........................................... 66

Make mbj File (Convert file to .mbj and save) .. 24

Mapping Window ........................ 39, 58

MASTER ............................................ 68

MASTER VOLUME ............................... 19

.MBJ ................................................. 37

Memory Menu .................................... 25

Menu(s) ................................. 21, 25, 43
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Mic ................................................... 21

Mic (Microphone) ............................... 21

Mic Channel ...................................... 29

Mic Echo ............................... 26, 28, 31

MIC IN jack ......................................... 5

MIC TYPE ............................................ 6

Microphone ................................... 4, 19

MIDI Adaptor Cable MDC-01 ............ 3, 5

MIDI Channel ..................................... 29

MIDI Channel ..................................... 45

MIDI Implementation Chart ................... 76

MIDI IRQ NUMBER ............................... 6

MIDI Mapper ..................................... 15

MIDI Menu ......................................... 44

MIDI Port Address switch ........................ 5

MIDI Soft Keyboard ............................. 57

MIDI/JOYSTICK connector ..................... 5

MINIMIZE button ................................ 19

Mixer(s) ................................. 26, 28, 29

Mode ................................................ 67

MUSIC .............................................. 68

N
New ................................................. 24

New .OMP file button ......................... 40

New OMP ......................................... 43

Normalize ......................................... 47

Normalize button ................................ 41

Note ................................................. 57

O
Octave .............................................. 45

OK ................................................... 68

.OMP .................................... 52, 59, 60

.OMP files ......................................... 61

One Play ........................................... 47

One Play button .................................. 41

Open .......................................... 24, 43

.OPL ......................................52, 59, 60

OPL Files ............................................ 61

OPL Wave File List .............................. 60

OPL4 Drive Panel ................................ 14

OPL4 Driver button .............................. 41

OPL4 DRV.COM................................. 16

Output Gain ....................................... 22

OUTPUT jack ........................................ 5

Output Mixer .......................... 28, 30, 36

OUTPUT TYPE ....................................... 6

P
Pan ................................................... 50

Parameter(s) ........................... 39, 45, 56

Parameters Menu ................................ 48

Paste ................................................. 46

Paste button ........................................ 41

Patch ................................................. 44

PATCH (Instrument) LIST ........................ 73

PC-SPK (Computer speaker) .................... 6

PITCH SHIFT buttons ............................ 19

Port (Address) ..................................... 67

POWER OFF button ............................ 19

PULL DOWN MENU button .................. 19

Quit Test ............................................ 69

R
RAM ................................................. 14

Region ............................................... 41

Release Rate ....................................... 49

RESTART ............................................ 71

Reverse .............................................. 47

Reverse button .................................... 41

RIGHT CHANNEL OUTPUT .................... 6

ROM (AWM wave table) ..................... 14

S
SampleEdit ......................................... 38

Sample Files ................................. 39, 61

Sample File List ............................. 37, 61

Sample Frequency ............................... 49

Sample Note ...................................... 49

Save ..................................... 24, 43, 68

Save As ....................................... 24, 43

Save button ........................................ 40

Saving the Effect Program ..................... 37

Scrollbar ............................................ 59

Search for Help on .............................. 50

Select All ........................................... 46

Setting Output Level and LFO Settings .... 22

Setting Up the YAMAHA OPL4 Driver .... 14

SETUP ................................................. 5

Sign .................................................. 29

Sign/Level/Value ............................... 30

Size .................................................. 59

SLIDERS ............................................. 19

Sound Card ................................. 4, 7, 8

SOUND EDGE APPLICATION SOFTWARE ... 17

Sound Test ......................................... 69

Source ............................................... 21

Source (sound source) .......................... 21

Speed ............................................... 22

Start button ......................................... 41

Status Bar .............................. 40, 41, 46

Stop button ........................................ 41

SURROUND ....................................... 28

Surround ............................................ 30

SYNTHESIZER .................................... 19

SYSTEM.INI ....................................... 13

T
Thru ............................................ 30, 31

Tile ................................................... 50

Toolbar ........................................ 40, 46

Total Level .......................................... 49

Transpose .......................................... 34

Tremolo Depth .................................... 50

TROUBLESHOOTING .......................... 72

Type ................................................. 22

type .................................................. 31

U
Undo ................................................. 46

Undo button ....................................... 40

Unzoom ............................................. 48

Unzoom button ................................... 41

Update .............................................. 59

V
Value ................................................ 29

Velocity ............................................. 45

Vibrato Depth ..................................... 50

View Menu ........................................ 46

VOICE ............................................... 68

Voice Cancel ......................... 26, 28, 30

VOICE CANCEL button ....................... 19

VoiceMorph ....................................... 21

Volume .............................................. 68

VOLUME SETTINGS ............................ 68

W
.WAV ............................................... 52

Wave Boost ....................................... 14

Wave files ................................... 52, 58

Waveform Editing Window .................. 39

Window Menu ................................... 50

WINDOWS APPLICATION .................. 18

Work area ......................................... 40

Y
YAMAHA Ex-MIDI ............................... 15

YAMAHA OPL4 .................................. 15

YAMAHA OPL4 Driver ......................... 14

Z
Zoom IN/Out button ........................... 41

Zoom Menu ....................................... 48



SOFTWARE LICENSING AGREEMENT

The following is a legal agreement between you, the end user, and Yamaha Corporation (“Yamaha”).
The enclosed Yamaha software program is licensed by Yamaha to the original purchaser for use only
on the terms set forth herein. Please read this licensing agreement with care. Opening this package
indicates that you accept all terms outlined herein. If you do not agree to the terms, return this package
unopened to Yamaha for a full refund.

1. GRANT OF LICENSE AND COPYRIGHT
Yamaha grants you, the original purchaser, the right to use one copy of the enclosed software
program and data (“SOFTWARE”) on a single-user computer system. You may not use it on more
than one computer or computer terminal.

The SOFTWARE is owned by Yamaha and is protected by Japanese copyright laws and all
applicable international treaty provisions. You are entitled to claim ownership of the media in which
the SOFTWARE is included. Therefore, you must treat the SOFTWARE like any other copyrighted
materials.

2. RESTRICTIONS
The SOFTWARE program is copyrighted. You may not engage in reverse engineering or
reproduction of the SOFTWARE by other conceivable methods.

You may not reproduce, modify, change, rent, lease, resell, or distribute the SOFTWARE in
whole or in part, or create derivative works from the SOFTWARE. You may not transmit or network
the SOFTWARE with other computers.

You may transfer ownership of the SOFTWARE and the accompanying written materials on a
permanent basis provided that you retain no copies and the recipient agrees to the terms of the
licensing agreement.

3. TERMINATION
The licensing condition of the software program becomes effective on the day that you receive the
SOFTWARE. If any one of the copyright laws or clauses of the licensing conditions is violated, the
licensing agreement shall be terminated automatically without notice from Yamaha. In this case,
you must destroy the licensed SOFTWARE and its copies immediately.

4. PRODUCT WARRANTY
YAMAHA WARRANTS TO THE ORIGINAL PURCHASER THAT IF THE SOFTWARE, WHEN
USED IN NORMAL CONDITIONS, WILL NOT PERFORM THE FUNCTIONS DESCRIBED IN
THE MANUAL PROVIDED BY YAMAHA, THE SOLE REMEDY WILL BE THAT YAMAHA WILL
REPLACE ANY MAGNETIC MEDIA WHICH PROVES DEFECTIVE IN MATERIALS OR
WORKMANSHIP ON AN EXCHANGE BASIS WITHOUT CHARGE. EXCEPT AS EXPRESSLY
SET FORTH ABOVE, THE SOFTWARE IS PROVIDED “AS IS,” AND NO OTHER WARRANTIES,
EITHER EXPRESSED OR IMPLIED, ARE MADE WITH RESPECT TO THIS SOFTWARE,
INCLUDING, WITHOUT LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE.

5. LIMITED LIABILITY
YOUR SOLE REMEDIES AND YAMAHA’S ENTIRE LIABILITY ARE AS SET FORTH ABOVE. IN
NO EVENT WILL YAMAHA BE LIABLE TO YOU OR ANY OTHER PERSON FOR ANY DAMAGES,
INCLUDING WITHOUT LIMITATION ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES,
EXPENSES, LOST PROFITS, LOST SAVINGS OR OTHER DAMAGES ARISING OUT OF THE
USE OR INABILITY TO USE SUCH SOFTWARE EVEN IF YAMAHA OR AN AUTHORIZED
DEALER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY
CLAIM BY ANY OTHER PARTY.

6. GENERAL
This license agreement shall be interpreted according to and governed by Japanese laws.
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If you encounter problems with this product that cannot be solved
by referring to this manual, please contact the MEDIA TECHNOLOGY DIVISION
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